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Preface

Thank you for placing your trust in this ELSA product.

Wireless networks from ELSA are economical alternatives or additions to
local wired networks (LANs). Notebooks and PCs can use mobile network
cards to communicate with one another or access wired networks via access
points and can even be integrated into the ISDN network.

Documentation
The accompanying documentation comprises:
® Manual

Hardware installation, description of the functions, operating modes and
sample configurations

® CD containing electronic documentation

All product manuals, basic technical information (e.g. wireless networks,
general networking technology, TCP/IP etc.), workshop with detailed ex-
amples of applications, reference section for general information includ-
ing a complete description of the menus.

Our online services (www.elsa.com) are available to you around the clock
should you have any queries regarding the topics discussed in this manual or
require any further support. In the Support file section under ‘Know-how', you
can find answers to frequently asked questions (FAQs). The KnowledgeBase
also contains a large pool of information. Current drivers, firmware, tools and
manuals can be downloaded at any time.

The KnowledgeBase can also be found on the CD. Just open the file
Wilisc\Support MISC\ELSASIDE\index. htm.
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Introduction

The advantages of wireless LANs are obvious: Notebooks and PCs can be set
up where they are wanted—problems with missing ports or construction al-
terations are a thing of the past with wireless networking.

Network links in conferences or presentations, access to resources in adja-
cent buildings and exchanging data with mobile units are only a few of the
options available with a wireless LAN.

The access point plays the central role in enabling these options in an exist-
ing wired network. All stations in the wireless network access the LAN via
the access point.

Your entire LAN is connected to the outside world via the integrated IP router
and the ISDN interface. Access to the Internet for the entire LAN or office
functions such as fax and answering machine at all workstations are only
some of the advantages offered by the ISDN router.

Notes on using wireless LAN devices

ELSA Wireless LAN products can use up to 13 radio frequency channels in a
frequency band between 2400 MHz and 2483 MHz. The devices are approved
for operation in all EU countries and Switzerland. Use of the devices is reg-
ulated throughout Europe by the 1999/5/EG guideline of the European Parlia-
ment and Council Directive of 9 March 1999 regarding Radio and
Telecommunication Terminal Equipment (R&TTE) and the mutual approval of
their conformity. Please observe the approved frequencies for individual
countries as listed in the appendix.

ELSA is not respansible for disturbances or interference caused by unautho-
rized modifications made to the devices. ELSA will not be held liable espe-
cially for the consequences of connecting external antennas or cables that
are not explicitly designed for use with ELSA LANCOM Wireless and Air-
Lancer devices.

See the appendix for more information on CE conformity.
The basic functions of a wireless network

This chapter introduces the basic functional principles of a wireless network.
The terms used will be explained and the structure and possible applications
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of wireless networks introduced. Detailed information on this and other top-
ics can be found in the electronic documentation on the CD.

Wireless network adapters connect individual notebooks and PCs to a Local
Area Network (LAN). As the usual network cables have been replaced by a
radio link in this case, we also refer to this as a Wireless Local Area Network
(WLAN).

Furthermore, the access point forms the bridge between LAN and WLAN.
The ELSA access point also can function as an Internet router or a wireless
bridge between two ethernet LANs. It has a slot for a wireless network
adapter (ELSA AirLancer MC-11) as well as a normal Ethernet connection on
the other side to exchange data between the two networks.

The maximum area in which wireless network adapters in mobile stations
and the access point can reach each other and exchange data is known as a
radio cell.

All of the standard functions of a wired network are also available in a wire-
less network: Access to files, servers, printers etc. is passible as is the inte-
gration of the mabile stations into an internal company e-mail system.

Operating modes

The following operating modes are available using ELSA wireless network
adapters and access points:

® Ad hoc network (peer-to-peer)

@ Infrastructure network

® Wireless bridge

® Wireless LAN + ISDN gateway

® Wireless LAN + DSL gateway

Use the wireless network cards to link two or more computers directly. All

computers in a WLAN can then communicate with one another with no addi-
tional hardware.
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This application is generally called a peer-to-peer network. In the language
of wireless networking, it is known as an ad hoc network.

All computers with wireless network cards are able to access a wired net-
work via an access point. The access point acts as the connection between
the LAN and the WLAN and it also forms the switching center for data traffic
within the WLANS.

Infrastructure network
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Awireless network with a access point is also referred to as an infrastructure
netwark.

This network type is ideally suited as an addition to existing LANs. The infra-
structure network is the ideal solution for expansion of a LAN in areas where
wiring is not possible or not economical.

Multiple access points can be used if the range of a cell is not sufficient to
link all mobile stations. This makes it possible to switch from one wireless
cell to another without interrupting the connection to the network.
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Radio cells can also overlap to ensure good coverage. Different channels (up
to 13 channels are available) can be selected to prevent interference
between the cells.

WLAN and The ELSA LANCOM Wireless IL-11 access point offers a special supplemen-

ISDN/DSL gateway  tary function. The access point connects both the wireless network and the
ISDN or DSL network simultaneously to the wired network via the ISDN inter-
face.

@

mu= IW '
I j

This enables additional applications such as access to the Internet for all
computers in the LAN and WLAN together with all the functions of an IP
router.
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What does the ELSA LANCOM Wireless IL-11
offer?

The following is an outline of the principal features of the device giving you
a quick overview of its capabilities.

Easy installation

Connect the LANCOM Wireless to the power supply.
Establish a link to the LAN.

Connect to a DSL port.

Plug in the ISDN cable.

Switch it on.

Go!

LAN connection

Access points for wireless networks by function in ELSA Ethernet environ-
ments. Use the 10Base-T connection and a hub or switch to connect the FLSA
LANCOM Wireless IL-11 to a 10 Mbit LAN or to a DSL modem.

WAN connection

The ELSA LANCOM Wireless IL-11 is connected to the Sy interface(s) of an
ISDN basic rate interface in point-to-multipoint configuration (multi-device
terminal) or in point-to-paint configuration (system terminal). The router au-
tomatically detects your port type and the D-channel protocol being used.
Switched connections using DSS1 or 1TR6 can also be used, as can
leased-line connections.

Operation with an ISDN leased line is not included in the standard delivery
scope of the router. The leased line option can be enabled by entering a code.

DSL connection

With special DSL firmware (on CD-ROM), you can connect your LANCOM to
a DSL modem (such as the T-DSL network offered by Deutsche Telekom).
Instead of connecting to the Ethernet, you can have quick access to the Inter-
net. This procedure can be switched in bath directions by using the corre-
sponding firmware.
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Configuration

Setting up and configuring the devices to your specific needs is made quick
and easy in Windows operating systems by the configuration tool supplied,
ELSA LANconfig.

The management tool WEBconfig is just as easy to use. It allows you to
access the configuration of the £L.SA LANCOM access paint or even load new
firmware using any HTML browser. Furthermore it is possible to access
device configuration via SNMP and TFTP.

For access to the device, the TCP/IP protocol has to be installed on the sta-
tions. The ELSA LANCOM access point can then be configured for a LAN,
WLAN or WAN connection. The unit can be maintained remotely via ISDN—
even before being configured after delivery.

Access to the device is possible from a WAN (via ISDN), WLAN or LAN. TFTP
is supported along with SNMP if configuring from the LAN or WLAN.

The integrated setup wizards from ELSA LANconfig and ELSA WEBconfig
help you get the unit operating in a few steps.

Software update

Your device has a flash ROM memory to ensure that its software remains
state of the art. This allows new firmware to be loaded onto the device with-
out the need to open it up.

The current version is always available to you on our online media and can be
loaded via the LAN, the WLAN or the WAN (ISDN).

FirmSafe

There is no risk involved with loading the new firmware: The FirmSafe func-
tion enables two firmware files to be managed on one device. If the new
firmware version does not function as desired after the upload you can simply
revert to the previous version.

If an error occurs during the upload (e.g. a transmission error) the functioning
previous version is automatically reactivated.

Intruder protection

Along with password protection and call number recognition (CLIP), the router
offers protection against unauthorized access to the company network by
means of a callback function which only permits a connection to be estab-
lished to previously defined ISDN telephone numbers only. Authentication
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mechanisms in PPP, firewall filters and IP masquerading complete the secu-
rity concept. Furthermare, login barring prevents any “brute force attacks”
and denies access to the router after a configurable number of login attempts
using an incorrect password.

Wireless and secure with WEP

The WEP (Wired Equivalent Privacy) encryption method attaches a 40-bit or
128-hit key to the wireless data. The data encryption and authentication of
the stations makes it as good as impossible for the data in transit to be inter-
cepted. This ensures a considerably higher level of data security in wireless
network operation. Additionally, station filters based on MAC addresses
make it possible to allow or deny individual stations access to the access
point.

Charge monitoring

Subscribing to “Advice of charge during connection” on the ISDN network
(AOCD) allows you to set the charge units available for a specified period for
the ISDN connection. This puts you in constant control of your phone hill.

If charge information is not available from your ISDN connection, you can also
limit the active ISDN connect time for a specified period. The router will not
permit the active establishment of connections once this time has elapsed.

Least-cost routing

Even if there is a large selection of telecommunications service providers you
can always use the cheapest ISDN lines using the least-cost router.

Automatic time check

In order to generate sound statistics and to select the correct connection
paths using the least cost router, the device always must have the exact time.
It can read the time from the ISDN network itself. The router's internal time
is always compared to ISDN time either each time a connection is estab-
lished or each time the device is switched on. Of course, the time can also be
set manually.

Channel bundling and compression

The device supports static and dynamic channel bundling via MLPPP and
BACP on the ISDN line. Stac data compression (hi/fn) can be used to achieve
increases in the data transfer rate of up to 400%.
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ELSA LANmonitor

Under Windows operating systems, this tool displays the status of the router
on the screen at all times. The most important information for every device
in the local network is displayed, such as:

® Connection status for each transfer channel

® Name of the remote site

® The connected unit module (router, LANCAPI)

® Connection duration and transmission rates

® Excerpts of the device statistics (e.g. PPP negotiation data)

Additionally, the software allows you to log and save the messages on the
PC for further processing.

AirLancer Client Manager

The ELSA AirLancer Client Manager is included with the AirLancer cards and
provides software tools for configuring AirLancer adapters and monitoring
and diagnosing wireless networks. The wireless connection of WLAN clients
to the access point is continuously monitored, and the current status is also
displayed. You have a choice of the following:

® Set the wireless parameters and user profiles

® Monitor and analyze the wireless network (site survey)

® Display the available access points

® Carry out tests and diagnostics on the card

® Monitor the signal strength

® Assign the WEP encryption key

Refer to the online help file for detailed information on the £LSA Airlancer
Client Manager.

Status displays

LED indicators on the front of your access point allow you to monitor the ISDN
and Ethernet connections and the current line connections, thus simplifying
the process of diagnosing any systems failures.

Statistics

The comprehensive statistics function lets you keep track of your ELSA LAN-
COM Wireless IL-11. These statistics give you all the information you need
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on the data packets transferred, for example, so that you can optimize the
configuration of your device.

DHCP
Your LANCOM provides the following DHCP modes:

® DHCP server, to assign IP addresses
® DHCP client, to receive addresses
® DHCP relay agent, to forward DHCP requests

With its factory-preset configuration, the device operates using a sophisti-
cated automatic mode, which makes it extremely easy to get the LANCOM
running either on an existing netwark or a new network.

DNS server

The router's DNS server functions allow you to set up links between IP
addresses and names of computers or networks. The correct route can be
directly assigned in the event of queries for known computer names.

The DNS server can also access the name and IP information from the DHCP
server and the NetBIOS module.

The DNS server can also serve as an effective filter for the users in your local
network. Access to specified domains can be denied to individual computers
or complete networks.

ELSA LANCAPI and ELSA CAPI Faxmodem

The main advantages of using LANCAP/are economic. The LANCAP/is a spe-
cial type of CAPI 2.0 interface through which various communications pro-
grams (e.g. ELSA-RVS-COM or ELSA-ZOC) via the network can access the
router.

Any waorkstation which has been integrated into the LAN (Local Area Net-
waork) can use LANCAPI to give unlimited access to office communication
functions such as fax and EuroFileTransfer. All functions are made available
throughout the network without the need to add hardware to the worksta-
tions. The office communications software simply needs to be loaded onto
the individual workstations.

A fax device is simulated at the workstation so that faxes can be sent. With
the LANCAPI, the PC forwards the fax via the network to the router which
establishes the connection to the recipient.
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Routing: Line connection and management

The router checks all data on the network to determine whether they have to
be sent to another network or computer. If data transfer is necessary, the
router establishes the connection itself and closes the connection once the
transfer is complete. Any partly used call charge units are used up fully if call
charge information is transmitted during the connection.

To reduce transfer costs, the router offers various filter options depending on
the mode of operation. These filters can be used to exclude data from being
tranmitted to all or part of the network. Data that belongs to specific services
(e.g. printing services) can also be excluded from transfer.

NetBIOS proxy

ELSA routers offer a special feature for the interconnection of Microsoft
peer-to-peer networks. With the integrated routing of IP NetBIOS packets,
the linking of Windows networks becomes child's play. The remote stations
relevant for the exchange of data are entered in a list to ensure that not every
NetBIOS packet results in the establishment of a connection.

As a NetBIOS proxy, the router answers the queries for known workstations
locally to prevent unnecessary connections from being established.

Accounting

Most data transfers through the ELSA router take place via dial-up connec-
tions, where the charges are calculated based on the online time, or via static
connections, where the charges are calculated based on the transferred data
volume. Only a small portion of users use true leased-line connections with
flat-rate charging.

For many users it is important to determine which of the immediate LAN com-
puters use the connection to the router and what charges they incur.

With its accounting feature, ELSA LANCOM Wireless IL-11 offers the ability
to breakdown online times and data transfer volumes for ISDN and DSL con-
nections based on the individual computers that use the connections. This
allows you to determine the incorrect configuration of the computer or router
quickly and allocate the resulting expenses to their appropriate causes.
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Roaming

The roaming feature lets you construct bigger wireless networks using any a
number of access points. When stations switch from one wireless cell to

another while connected, they are automatically logged off of the previous

access point and logged onto the next.
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Installation

This section will help you to connect as quickly as possible. First we will
describe the contents of the package and introduce the device itself. After
that we will explain how to connect the unit and put it to use quickly.

The following information is intended for experienced users familiar with
hardware and network configuration.

Package contents

Please ensure that the delivery is complete before beginning with the instal-
lation. The package should include the following components:
® C[LSALANCOM Wireless IL-11

® F£ISA Airlancer wireless network adapter with integrated antenna
(already in the access paint)

® Power adapter

® LAN connector cable
(also suitable when connecting to a DSL modem)

® ISDN connection cable

® Documentation

® CD containing ELSA LANconfig, other software and electronic documen-
tation

If anything should be missing, please contact your dealer.

System requirements

PCs that are to communicate with a LANCOM Wireless access point have to
meet the following minimum requirements:

® The TCP/IP protocol must be installed.

® A web browser must be installed (for HTML configuration).

® An ELSA AirLancer or other ethernet card has to be installed.

Several programs and drivers, such as ELSA LANconfig and ELSA LANCAPI
require a Windows operating system.
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23 Install TCP/IP on your workstation

To establish a connection to a LANCOM access point for the first time, the
TCP/IP protocol has to be set up. The following describes how to install this
protocol on various operating systems.

2.31 Windows 95 and Windows 98

Using Windows 95 and Windows 98 as examples, this section will show
what needs to be done, if it is not already done for you, to ensure smooth
communication between computers in a TCP/IP network with the router con-
nected to the workstations.

® Installing TCP/IP

To install TCP/IP, click Start ' Settings ~ Control Panel - Network
Add  Protocol. Select the manufacturer ‘Microsoft' and the
‘TCP/IP" network protacal.

Allocate IP addresses (using DHCP)

If you are going to use the router as a DHCP server, set the workstations
to obtain IP addresses automatically: Start '~ Settings "~ Control
panel - Network - TCP/IP "~ Properties "~ IP address »> Auto-
matically receive IP address. Also, delete any existing entries for
DNS servers and gateways (found under the ‘Gateway' and 'DNS Config-
uration' tabs). When the computer is restarted, it then searches for a
DHCP server on the network and lets it assign an IP address to it.

Setting fixed IP addresses (not using DHCP)

If you are not going to use a DHCP server on your network, assign the
workstations fixed IP addresses: Start '~ Settings '~ Control panel
Network '~ TCP/IP - Properties '~ IP address » Determine IP
address.

Assign unique IP addresses, for example taken from a reserved range of
addresses. For example, the workstations can be assigned addressed
from "10.1.1.2" to '10.1.1.253", the router can be given '10.1.1.1" and all
can have the subnet mask of "255.255.255.0". To test whether or not a
specific IP address, such as '10.1.1.1", is free, enter pi ng 10.1.1.1
in a DOS session If you do not receive a response, the address is most
likely free.
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2.3.2

@ Entering the gateway and DNS server (not necessary when using DHCP)
On the workstation computers, specify the address of the local network
router as the gateway and as the Domain Name Server (DNS server):
Start - Settings - Control panel '~ Network "~ TCP/IP > Prop-
erties - Gateway and DNS configuration. Also enter a host name
on the DNS configuration page. In doing so, use the name of the PC,
which ideally matches the user's name, to maintain a certain amount of
consistency.

® Checking the IP configuration
Under Windows 95 and Windows 98, you can view the current IP config-
uration of your computer with by using Start > Run »» winipcfg.
Among other information, this shows you which IP address was assigned
to the computer by the DHCP server and which addresses have been
specified for DNS servers and the gateway.

Windows NT 4.0

Using Windows NT 4.0 as an example, this section will show what needs to
be done, if it is not already done for you, to ensure smooth communication
between computers in a TCP/IP network with the router connected to the
workstations.

® Installing TCP/IP
To install TCP/IP, click Start ' Settings '~ Control Panel - Network
Protocols '~ Add. Select the 'TCP/IP protocol' network protocol.
® Allocate IP addresses (using DHCP)

If you are going to use the router as a DHCP server, set the workstations
to obtain IP addresses automatically. To do so, select Yes when com-
pleting the network protocol installation.

TCP/IP Setup

If there is 8 DHEP serveron your network, TEPAP can be configured to dynamically provide an IP address. [Fyou are
hot sure, azk pour system administrator. Do pou wish to use DHCP?

Windows then copies the required files and, when finished, requests you
to reboot.
® Setting fixed IP addresses (not using DHCP)

If you are not going to use a DHCP server on your network, assign the
workstations fixed IP addresses: Start '~ Settings '~ Control Panel
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Network ' Protocols "~ Properties. This tab also lets you set the
standard gateway.

Microsoft TCP/IP Properties

IP ddress | DNS | WINS Address | Routing|

An |P address can be automatically assigned to this netwark card
by 3 DHEP zerver. |F pour network does not have a DHCP server,
ask pour network. administrator for an addiess, and then type itin
the space below.

Adapter.

" Obtain an P address from & DHEP server
T i M 4 Sl e e el e s s e e

1P ddress: moa 2

Subnet Mask: 1255 255 260 0 |
Default Gateway: i . . |

Advanced.
’TI Cancel i Apply I

Assign unique IP addresses, for example taken from a reserved range of
addresses. For example, the workstations can be assigned addressed
from "10.1.1.2" to '10.1.1.253", the router can be given '10.1.1.1" and all
can have the subnet mask of "255.255.255.0". To test whether or not a
specific IP address, such as '10.1.1.1", is free, enter pi ng 10.1.1.1
in a DOS session. If you do not receive a response, the address is most
likely free.

@ Entering the DNS server (not necessary when using DHCP)

On the workstation computers, specify the address of the local network
router as the Domain Name Server (DNS server) on the 'DNS' tab. Also
enter a host name on the DNS configuration page. In doing so, use the
name of the PC, which ideally matches the user's name, to maintain a cer-
tain amount of consistency.
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Microsoft TCP/IP Properties [ 7] x]
IP Acdress DS | WINS Addiess | Routing|

Domain Name System [ONS]

Host Name: Damain:

1~ DNS Service Search Order
g,
[y 4
Add Edi Fee |
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® Checking the IP configuration

Under Windows NT 4.0 you can query the current IP configuration of your
computer with Start > Run > ipconfig. This shows you which IP
address was assigned to the computer by the DHCP server and which
addresses have been specified for the gateway (not for the DNS server).

233 Windows 2000

With Windows 2000, helpful hardware setup wizards provide support when
you install the new hardware. If your network card is not detected during sys-
tem startup, launch the hardware wizard by selecting

Start > Settings > Control Panel > Add/Remove Hardware.

@ Select to search for new hardware and then select the 'Add a new device'
from the list that follows and click Next >.

(@ The search should detect the network card. Click again Next>. The sys-
tem then configures the new hardware and a LAN connection.

® To verify the new LAN connection, open its window by selecting

Start > Settings > Network and Dialup Connections

From there, click the connection with the right mouse button and open its
properties.

[ ELSA LANCOM Wireless IL-l | )




(EEZH nstallation |

24

241

LEDs

@ The dialog that appears contains a list box containing the installed net-
work components. TCP/IP should be listed in any case.

(® Select its entry and click the Properties... button.

This opens a dialog where you can define all of the properties for this network
protocol. The procedures for setting address, DHCP, gateway and DNS are
the same here as in Windows 98.

Introducing the ELSA LANCOM Wireless IL-11

This section introduces the unit's hardware. It covers the unit's display ele-
ments and connection options.

The front of the unit

You will find a number of LEDs as display elements on the front panel.

\/

© This LED shows the send/receive status of the card:

O 0Off—no wireless activity
O Blinking—wireless data being sent/received
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© The second LED indicates the card's operating mode:

O Lit green—standard mode
O Blinking green—the card is in energy-saving mode
© The 'Power/Msg' LED on the access point lights up briefly when the

power is switched on. After the self-test, either an error is output by a
flashing light code or the device starts and the LED remains lit.

off ‘ Device off

green ‘ 1 x short Boot procedure (test and load) started
green ‘ flashing Display of a boot error (flashing light code)
green ‘ Device ready for use

O The 'Sy Status' LED on the access point shows the activity on the D-chan-
nel.

© The 'WAN Channel-1" LED on the access point shows the activity on the
first B-channel on the ISDN port.

@ The 'WAN Channel-2' LED on the access point shows the activity on the
second B-channel on the ISDN port.

© The LAN Tx/Rx'LED on the access point indicates activity on the wireless
network and the LAN.

© The LED 'LAN link' on the access point indicates data activity in the Eth-
ernet network.

© The Reset button is recessed in the case and can only be reached with a
pointed object such as a paper clip. Press the Reset button until all of the
LEDs light up to reset the unit to its factory defaults.

The status of the ISDN connection

This LED shows the status of the Sy connection:

off Not connected or no S voltage
(often, the Sy voltage is disabled at ISDN connections
after certain length of inactivity)

green flashing Initializing (establishing contact with the connection
point)
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green operational
(Sq bus activated, TEl exists and D channel protocol
checked)
green ‘ Power off LED is on, but power LED is off: unit in boot monitor
WAN These LEDs indicate the status of the corresponding logical ISDN-WAN chan-
Chan! nels (in both router and CAPI modes):
Chan2
off Channel idle
red flashing incoming call pending
green flashing outgoing call being executed
red Channel is physically established/protocol negotiation
in process
green Corresponding protocol negotiation (X.75, PPP, etc.)
completed; channel is logically online
green/red | short red flashes Indicate a received data packet
(duration approx.
1/10)

The ISDN WAN channels do not have any fixed assignments to B channels!
The connection is active and incurring charges so long as the 'Chanl' or
& ‘Chan2' LED is green!

WAN This LED indicates whether the current ISDN connection is static or using
Chan 1+2 dynamic channel bundling.

off ‘ no connection or no bundle connection active

green ‘ static or dynamic bundle connection active
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2.4.3 The bottom of the unit

Now turn the whole thing upside down and take a look at the bottom. There a
you'll find:

AN S,
| 212

o © ©

@ Connection for power supply unit
© 10Base-T network connection
© ISDN S port

25 How to connect the device

@ Connect your ELSA LANCOM Wireless IL-11to the LAN. Plug the network
cable (supplied) into the 10Base-T terminal of the device and into a free
network connector on your local network (or into a free socket on a hub
in your LAN). The cable for the LAN connector is labeled with a colored
bend-proof protector.

(® Connect your ELSA LANCOM Wireless IL-11to the ISDN network. To do
so, connect the supplied ISDN line connection cable to the ISDN/Sg ter-
minal on the unit and to an ISDN/Sy multi-device terminal or system ter-
minal (point-to-multipoint or point-to-point configuration).

® Connect the AC adapter to the device and switch it on. After a short
device self-test the ‘Power/Msg’ LED will be permanently lit. The 'LAN
Link' LED indicates that your router is correctly connected to the LAN.

2.6 Software installation

The ELSA LANconfig configuration software for Windows operating systems
enables you to set up your router easily and conveniently for the desired
application. To use it, first install £LSA LANtools from the CD onto your sys-
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tem. With other operating systems, you can use ELSA WEBconfig in an
HTML browser to carry out the configuration.

You will need a Windows PC on the LAN to run £LSA LANconfig. ELSA also
provides a Linux version of ELSA LANconfig which can be downloaded from
their website.

@ Install the TCP/IP network protocol on the computer that will be used to
set up your device.

(@ Theninstall ELSA LANconfig. If the setup program does not start up auto-
matically after insertion of the ELSA LANCOM CD, start Windows
Explorer, click on ‘autorun.exe' on the ELSA LANCOM CD and follow the
instructions in the install program.

Quickstart

The following steps should help you get your device running quickly and eas-
ily. Choose from three different installation scenarios:

The TCP/IP protocol is installed on the system and there is no DHCP
server on the LAN

In this case, the LANCOM activates the DHCP server in automatic mode. It
assigns IP addresses in the range of 10.x.x.x. You can assign a fixed IP
address to the LANCOM or let it be assigned automatically. In the later case,
the LANCOM is assigned the address 10.0.0.1.

The TCP/IP protocol is installed on the system and there is already a
DHCP server on the LAN

The LANCOM acquires its IP address from the DHCP server on the LAN. LAN-
config finds the LANCOM at its address. The setup wizard asks for a static
IP address. Because the address is previously unknown, you cannot access
the LANCOM using WEBconfig.

The TCP/IP protocol is installed on the system with a fixed IP
address

In this case, LANconfig finds LANCOM at the client computer's address,
which ends in 254 (x.x.x.254). The setup wizard asks for a static IP address.
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2.1.2

The wizards

The following wizards, which make it very easy to set up and configure the
ELSA LANCOM Wireless IL-11, are available in ELSA LANconfig and ELSA
WEBconfig:

Basic settings

Changing security settings

Setting up Internet access

Selecting the Internet provider

Preparing remote access service (RAS)

Connecting two local networks

Wizards in ELSA LANconfig

@ Start the software £LSA LANconfigwith Start > Programs > ELSAlan
» ELSA LANconfig.

(@ Select your ELSA LANCOM Wireless IL-11 in the list of devices and call
up the wizards.
Wizards in ELSA WEBconfig

(@ Launch your browser and enter the device's IP address, which you config-
ured in the basic settings, into the address field. If you did not specify an
IP address while carrying out the basic settings, the address is '10.0.0.1".

(@ The start page provides links to the wizards.

The wizards guide you through the individual configuration steps. Each step
is accompanied by an explanation of its values. The following provides a
detailed description of the basic settings for the ELSA LANCOM Wireless
I-11.

Basic settings

With the basic settings, you assign a name to the unit and define the IP
addresses for operation in the local network.
ELSA LANconfig

The first time ELSA LANconfig is run, the new device is detected on the
TCP/IP network and can immediately be configured. A wizard starts automat-
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ically to help you with the basic configuration of the unit; it can also perform
the complete basic configuration for you.

The start page for automatic configuration does not appear in all described
cases. In some cases you are asked to enter an IP address in the next step

(®).

@ Start the new software with Start > Programs »> ELSAlan > ELSA
LANconfig.

=0

LANCOM 2000 Dffice - Basic settings

Before you can set up your new device, some settings for
the operation within pour network. must be defined.

IF pou are not yet Familiar with networks and this device is
the only router in your netwark, then these seftings can be
defined automatically

Basic settings for network. operation:

Al settings to be defined automatically

1~ | wish ta define the settings myself

< Back I Hext > I Cancel I

(@ Select the option 'All settings to be defined automatically' if you are net
familiar with netwarks and IP addresses and one of the following condi-
tions applies:

O You have not yet used IP addresses in your network but would like to
do so starting now. You are not concerned about the specific IP
addresses that will be used. The router as a DHCP server will auto-
matically set and assign the IP addresses for all devices in the net-
work (LAN and WLAN).

or

O You do not want to use IP addresses because you are using a pure
Windows network, for example.

If you are not sure whether your network already uses IP addresses, click on
Start » Run, enter wi ni pcf g on the command line and click OK. If the
next window shows the value '0.0.0.0" in the field 'IP address’, the computer
has never had an IP address.

Under Windows NT you can check IP addresses with the command
i pconfig.

o QR = @
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® Select the option 'l wish to define the settings myself' if you are familiar
with networks and IP addresses and one of the following conditions
applies:

O You have not yet used IP addresses in your network but would like to
do so starting now. However, you wish to set the IP address for the
router and assign it an address from an address range reserved for
private use, e.g. '10.0.0.254" with the network mask '255.255.255.0".
At the same time you will set the address range that the DHCP server
uses for the other devices in the network (so long as the DHCP server
is not switched off).

O You have previously used IP addresses for the computers in your LAN.
Assign the router a free address from the previously used address
range, and select whether the router should run as a DHCP server or
not.

You can find more information on the general structure of networks and set-
ting IP addresses in the electronic documentation on the ELSA LANCOM CD.

@ Enter a password for access to the unit and choose whether to use it as
a DHCP server on your LAN.

Disable "Automatically configure workstations via DHCP' only if you want to
use IP addresses on your network or already use another DHCP server. The
functions of the DHCP server are described in this manual on CD.

ELSA WEBconfig

If you do not wish to or cannot use ELSA LANconfig (e.g. because you have
installed a different operating system), you can configure the basic settings
using a normal HTML browser.

(@ Start your browser.

O If you do not yet have a DHCP or DNS server on your LAN, the router
reacts to any name (like 'LANCOM' or 'Router') that you specify in the
address field. The startup page will appear automatically.

O If you already use a DHCP server or work with fixed IP addresses on
your LAN, enter the address as 'x.x.x.254" in the browser's address
field, where 'x.x.x' stands for the currently configured range of
addresses.
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From this point on, the procedure is the same as for the ELSA LANconfig.
ELSA LANCOM Wireless IL-11

om

LANCH

(ELSA LANCOM Wireiess IL-11 2.10.0014 /05 10.2000)

Setup Wizards
G Basic Seftings
&% Security Seftings

: &% Setup Internst Access
¥ & Selection of Internet Provider
Y &Y Setup a RAS Account

@4 Connsct Two Local Area Netwarks

5 Expert Configuration

€ Save Configuration

5 Load Configuration

& Perform a Firmware Upload

®19.10.2000 1624
4 Entry Page [ELSAl ELSA Homepage

Telnet

Open a telnet connection to the address '10.0.0.254" if you have not used IP
addresses in your network to date, or the address 'x.x.x.254', in which 'x.x.x’
stands for the address range previously used in the network.

=IO

Procedure example:

(@ Start the telnet connection by clicking Start » Run and entering t el -
net 10. 0. 0. 254 on the command line.

(@ Set the IP address on the LAN/WLAN:

cd /setup/ TCP-1P
set intranet adr. 10.0.0.1
set intranet mask 255.255.255.0

When the Internet address is changed, the telnet connection is interrupted.

=IO

® Set up DHCP
cd / set up/ DHCP/
dir
set operating on

O Even if the entries at this point are not very clear without further explanation,
H you can reach the same destination as with the setup with ELSA LANconfig!
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With these settings, you have completed making your new router known on

the local network. The router itself is addressable using the IP address of
10.0.0.1". After you reboot your system, all units on the local network will be a
assigned IP addresses by the DHCP server in the router. It will use an address

pool from "10.0.0.2" to '10.0.0.253" automatically.
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3.2

Configuration and management

ELSA access points are always delivered with up-to-date software in which
a number of the settings have already been prepared for you.

It will nevertheless be necessary for you to add some information and config-
ure the router to your specific needs. These settings are made as part of the
configuration process.

This section will show you the programs and routes you can use to access the
device and set it up.

And, if the team at ELSA has produced new firmware with new features for
your use, we will show you how to load the new software.

Radio or wired: configuration approaches

With the configuration via WLAN and LAN or the remote configuration via
ISDN, you can access the access point from any computer on the WLAN, LAN
or WAN (ISDN). However, you can restrict or block the access altogether by
using the IP access list.

The configuration of ELSA LANCOM Wireless IL-11requires the use of either
ELSA [ANconfig for Windows, ELSA WEBconfig or Telnet (supplied with
most operating systems). ELSA LANconfigis supplied with your device. You
can always obtain up-to-date releases from our online media.

Configuration using ELSA LANconfig

Start £LSA LANconfig e.g. via the Windows taskbar with Start '~ Programs
ELSAlan ~ ELSA LANconfig ELSA [ANconfig searches the local area
network for devices.

Just click on the Browse button or call up the command with Device
Find to initiate a search for a new device manually. ELSA LANconfig will
then prompt for a location to search. You will only need to specify the local
area network if using the inband solution, and then you're off.
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Once ELSA LANconfig has finished its search, it displays a list of all the
devices it has found, together with their names and perhaps a description,
the IP address and its status.

e ELSA LANconfig =1 E3
Device Edit %iew Toolz Help
N R E N = N =]
I [ Description Address [ Sratus
10.0.0.1 Ok

Glasgow Wer. 0.92 [28.07.99) SM. 8829.000.260

Two different display options can be selected for configuring the devices with
ELSA LANconfig:

@ The 'simple display' mode only shows the settings required under normal
circumstances.

@ The 'complete display' mode shows all available configuration options.
Some of these settings should only be modified by experienced users.

Select the display mode in the View » Options menu.

Double-clicking the entry for the highlighted device and then clicking the
Configure button or the Edit > Edit Configuration File option reads the
device's current settings and displays the 'General' configuration selection.

The remainder of the program's operation is pretty much self-explanatory or
you can use the online help. You can click on the question mark top right in
any window or right-click on an unclear term at any time to call up context-
sensitive help.

Configuration with ELSA WEBconfig

You can configure the basic settings of the device from any web browser,
even a simple text-based browser. ELSA WEBconfig provides setup wizards
similar to LANconfig, making the configuration procedure for the LANCOM
Wireless as comfortable as possible from any operating system.

To establish a connection to the LANCOM Wireless, there has to be a LAN

connection present using the TCP/IP protocol. Access generally is estab-
lished using the device's IP address:
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http://<LANCOM | P address>

A LANCOM Wireless that has not be reconfigured or has been reset will even
respond to all IP addresses. A prerequisite is that the last set of numbers in
the IP address is ‘254" (e.g. http://10.0.0.254 and http://192.168.0.254).

Extensive, context-sensitive documentation for each WEBconfig page and
field is available at all times in WEBconfig by selecting the 'Help (Reference
Manual)' link.

HTTP module

Use the HTTP module to define the document root for the HTML help files
under ELSA WEBconfig. The preset defaults refer the help link to the ELSA's
website. If you want to store the help files locally, you can enter here the
directory where the files are kept.

Ideally, keep the help files on a server that is always accessible. Use the fol-
lowing syntax when specifying the directory.

® Onalocal computer (for example):
file:///C:\Program Fil es/ ELSAl an/ HTM.Ref / 500/ 4/ 1

® Onaserver (for example):
http:// <l P address of the server>/HTM.Ref/500/4/1

Note that the path for the ELSA LANCOM Wireless IL-11is always completed
as 500/ 4/ 1 and has to be configured as such locally.

The latest versions of the HTML help files are always available for download
at ELSA's website.

Configuration using Telnet
Start up the configuration (e.g. from a DOS box) using Telnet with the com-
mand:
C.\>Telnet 10.0.0.1
Telnet will then establish a connection with the device using the IP address.

After entering the password (if you have set one to protect the configuration),
all commands are available from the 'Configuration commands' section.
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Configuration using a dial-up connection

Configuring routers at remote sites is particularly easy using the remote con-
figuration method via a dial-up connection. The device is accessible by the
administrator immediately without any settings being made after it is
switched on and connected to the WAN interface. This means that you save
a lot of time and costs when connecting other networks to your network
because you do not have to travel to the other network or instruct the staff
on-site on configuring the router

You can also reserve a special calling number for remote configuration. Then
the support technician can always access the router even if it is really no
longer accessible due to incorrect settings.

This is what you need for remote configuration

® A computer with a PPP client, e.g. Windows Dial-up Networking
® A program for inband configuration, e.g. £ELSA LANconfig or Telnet

This is how you prepare the remote configuration
(@ Attach the router to the power supply.
@ Connect the device to a WAN interface.

The first remote connection using a Dial-up Networking
and ELSA LANconfig

® Inthe ELSA LANconfig program select Device > New, enable 'Dial-up
connection' as the connection type and enter the calling number of the
WAN interface to which the LANCOM Wireless is connected. If you
wish, you can also enter the time period after which an idle connection is
to be disconnected automatically.

@ ELSA [ANconfig now automatically generates a new entry under Dial-up
Networking. Select a device that supports PPP (e.g. the NDIS-WAN
driver included with the LANCAPI) for the connection and press OK to
confirm.

(® Then the ELSA LANconfig program will display a new device with the
name 'Unknown' and the dial-up call number as the address in the device
list.
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Once the entry appears in the device list the Dial-up Networking connection
is broken.

(® You can configure the device remotely just like all other devices. ELSA
LANCconfig establishes a dial-up connection enabling you to select a con-
figuration.

The first remote connection using a PPP client and Tel-
net

(@ Establish a connection to the LANCOM Wireless with your PPP client
using the following details:

O User name 'ADMIN'

O Password as set on the LANCOM Wireless, factory default setting is
no password

O An IP address for the connection, only if required

(@ Open a Telnet session to the LANCOM Wireless. Use the following IP
address for this purpose:

O '172.17.17.18', if you have not defined an IP address for the PPP cli-
ent. The LANCOM Wireless automatically uses this address if no
other address has been defined. The calling PC then responds to the
IP address '172.17.17.17".

O Raise the IP address of the PC by one, if you have defined an address.
For example: If you have defined the IP address '10.0.200.123' for the
PPP client, the LANCOM Wireless will respond to '10.0.200.124".
Exception: If the digits 254" are at the end of the IP address, the
router responds to 'x.x.x.1".

® You can configure the LANCOM Wireless remotely just like all other
devices.

Limiting remote configuration

The PPP connection of any other remote site to the router, of course, will only
succeed if the device answers every call with the corresponding PPP settings.
This is the case using the factory default settings because the default proto-
col (default layer) is set to PPP.

You may, however, want to change the default layer for LAN-to-LAN connec-
tions, for example, to a different protocol after the first configuration run.
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Then the device will no longer take calls on the dial-up connection using the
PPP settings. The solution to this is to agree upon a special calling number for
configuration access. If the device receives a call on this number, it will
always use PPP, regardless of any other settings made on the router. Only a
specific user name which is automatically entered by the ELSA LANconfig
program during call establishment will be accepted during the PPP negotia-
tions.

@ Switch to the 'Security' tab in the ‘Management' configuration section.

@ In the 'Configuration access' field, choose whether the configuration is
fully accessible, read-only or not accessible from remote networks.

Alternatively, enter the following command during a Telnet or terminal
connection:

set/ setup/ confi g- nodul e/ wan-config
[on] [read][of f]

If you wish to block access to the router from the WAN entirely, set configu-
ration access from remote networks to ‘denied".

® Enter a calling number of your connector as the calling number in the
‘configuration access' area, which is not used for other purposes.

Alternatively, enter the following command:
set /setup/config-nodul e/ Farconfig 123456

@ You can protect the configuration of the device by assigning a password.
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AACHEN Configuration EHE

Configure: I M anagement = l

Generall Interfaces  Security | Ehargingl Date.-"TimeI SNMF’I

r— Configuration acce:

From the local network:

From remate networks: Iallowed 'l
Mumber [MSHELZ): I‘I 23456

— Configuration password

Passward: I

[ Always ask for new password if no one specified

r— Configuration lock

Lock configuration after: |5 login failures
Lock configuration far: |5 minutes

()8 ‘EI Cancel |

Alternatively, enter the following command during a Telnet or terminal
connection:

passwd
You will then be prompted to enter and confirm a new passwaord.

Configuration using SNMP

The Simple Network Management Protocol (SNMP V.1 as specified in RFC
1157) allows monitoring and configuration of the devices on a network from
a single central instance.

Detailed information on the configuration of ELSA devices with SNMP can be
found in the electronic documentation on the CD.

New firmware with FirmSafe

The software in the ELSA device is constantly being updated. We have fitted
the devices with a flash ROM which makes child's play of updating the oper-
ating software so that you can enjoy the benefits of new features and func-
tions. No need to change the EPROM, no need to open up the case: simply
load the new release and you're away.
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This is how FirmSafe works

FirmSafe makes the installation of the new software safe: The used firmware
is not simply overwritten but saved additionally in the device as a second
firmware.

Of the two firmware versions saved in the device only one can ever be active.
When loading a new firmware version the active firmware version is not
overwritten. You can decide which firmware version you want to activate
after the upload:

® 'Immediate”: The first option loads the new firmware and activates it

immediately. This can result in the following situations:

O The new firmware is loaded successfully and works as desired. Then
all is well.

O The device no longer responds after loading the new firmware. If an
error occurs during the upload, the device automatically reactivates
the previous firmware version and reboots the device.

‘Login": To avoid problems with faulty uploads there is the second option

with which the firmware is uploaded and also immediately booted.

O In contrast to the first option, the device will wait for five minutes
until it has successfully logged on. Only if this login attempt is suc-
cessful does the new firmware remain active permanently.

O If the device no longer responds and it is therefore impossible to log
in, it automatically loads the previous firmware version and reboots
the device with it.

‘Manual': With the third option you can define a time period during which
you want to test the new firmware yourself. The device will start with
the new firmware and wait for the preset period until the loaded firm-
ware is manually activated and therefore becomes permanently effec-
tive.

How to load new software

There are various ways of carrying out a firmware upload (which is the term
given to the installation of software), all of which produce the same result:
® F£LSA [ANconfig

® £1SA WEBconfig

® TFTP
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All settings will remain unchanged by a firmware upload. All the same you
should save the configuration first for safety's sake (with Edit > Save con-
figuration to file if using £LSA LANconfig, for example).

If the newly installed release contains parameters which are not present in
the device's current firmware, the router will add the missing values using
the default settings.

ELSA LANconfig

When using £LSA LANconfig, highlight the desired device in the selection list
and click on Edit '~ Firmware Management - Upload New Firmware,
or click directly on the Firmware Upload button. Then select the directory
in which the new version is located and mark the corresponding file.

ELSA LANconfig then tells you the version number and the date of the firm-
ware in the description and offers to upload the file. The firmware you
already have installed will be replaced by the selected release by clicking
Open.

You also have to decide whether the firmware should be permanently acti-
vated immediately after loading or set a testing period during which you will
activate the firmware yourself. To activate the firmware during the set test
period, click on Edit > Firmware Management > After upload, start the
new firmware in test mode.

ELSA WEBconfig

Launch your browser and enter the device's IP address, which you configured
in the basic settings, into the address field. If you did not specify an IP
address while configuring the basic settings, the address is ‘http://
10.0.0.254'.

There is a link on the start page called 'Upload New Firmware'. In the next
window, you can search for the firmware file in the directory index and then
click the Upload button.

TFTP

With TFTP you can use the writeflash command to install new firmware. To
transmit a new firmware version to a device with the IP address
194.162.200.17, you would enter the following command under Windows NT
for example:

tftp -1 194.162.200.17 put Ic_wlI1iu.200 writeflash
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This command sends the corresponding file to the input IP address using the
writeflash command. Binary file transfer must be set for TFTP. However,
many systems have the ASCII format preset. This example for Windows NT
shows you how to achieve this by using the -i' parameter.

The device is booted up following a successful firmware upload and this acti-
vates the new firmware switch directly. If an error occurs during the upload
(write error in the flash ROM, TFTP transmission error or similar) FirmSafe
activates the previous firmware. The configuration remains in operation.

With TFTP, other configuration commands can be performed too. The syntax
is best demonstrated with the following examples:

® tftp 10.0.0.1 get readconfig file1: Reads the configuration from the device
with the address 10.0.0.1 and saves it as file1 in the current directory.

® tftp 10.0.0.1 put file1 writeconfig: Writes the configuration from file1 to
the device with the address 10.0.0.1.

® tftp 10.0.0.1 get dir/status/verb file2: Saves the current connection infor-
mation in file2.

What's happening on the line?

After the basic setup of the devices, further important information can be
gained with regard to the parameters still to be modified, especially by
observing the data flow on the various ports of the router.

In addition to the device statistics that can be read out during a telnet or ter-
minal session or with ELSA WEBconfig, a variety of other options are also
available.

ELSA LANmonitor

The ELSA LANmonitorincludes a monitoring tool with which you can view the
most important information on the status of your router on your monitor at
any time under Windows operating systems. Many of the internal messages
generated by the device are converted to plain text, thereby helping you to
troubleshoot.
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Installing ELSA LANmonitor

Usually, ELSA LANmonitoris automatically installed together with the ELSA
LANconfig configuration software on the computer from which you wish to
configure your router or access point.

If ELSA LANmonitor is not yet installed on your computer, place the ELSA
LANCOM CD in your CD drive. If the setup program does not start up auto-
matically after insertion of the CD, start Windows Explorer, click on 'auto-
run.exe' on the ELSA LANCOM CD and follow the instructions in the install
program.

During the installation you should activate the 'LANmonitor'.

With ELSA LANmonitor you can only monitor those devices that you can
access inband, i.e. via the local network. Your computer must also have the
TCP/IP network protocol installed on it. With this program you cannot access
any router connected to the serial interface.

DSL firmware for ELSA LANCOM Wireless

With the accompanying DSL firmware, the £LSA Wireless router can be con-
figured for communication via DSL.

Make sure that no ethernet network connections are active after uploading
the firmware. It is advised that you should setup connection to the access
point via WLAN. Wireless connection to the access point is also possible
after the firmware upgrade.
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Before upgrading the firm- - After the firmware upgrade, connection to an Eth-
ware, network access is pos- ernet network is no longer possible! The Ethernet
sible via the Ethernet interface on the Wireless router is now available
interface. for a DSL connection.
Procedures

@ Disconnect the access point from the network, and establish a connec-
tion via the wireless network card (WLAN connection).

(@ Insert the accompanying CD in the computer, which is connected with the
access point via WLAN.

® |Initialize ELSA LANconfigand select

Processing > Firmware Management » Upload New Firmware
Open the firmware directory on the CD and highlight the file.
LC Wreless_|L-11_DSL_200

After copying the firmware, the system should be reset. Then the DSL con-
nection can be set up.

If you would like to delete this setup and install your access point for LAN
operation within an Ethernet network, proceed likewise.
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Operating modes and functions

This section is an introduction to the functions and operating modes of your
device. Itincludes information on the following points:

Wireless connections
Security for your configuration
Security for your LAN

Security for your WLAN

Call charge management

DSL connections

ISDN connections

Automatic address administration with DHCP
DHCP server

Least-cost router

ELSA LANCAPI

Time check

Alongside the description of the individual points, we will also give you
instructions to support you as you configure your device.

Please refer to the electronic documentation for a detailed description of all
parameters and menus.

Establishing wireless connections

This section explains how to get a wireless network going. There are several
different basic operating systems:

® Ad hoc network

@ Infrastructure network

® Point-to-point netwark (wireless bridge)

® Wireless Internet gateway ISDN

® Wireless Internet gateway DSL

The netwaork structures are described in the introduction of this manual. For

information on the topic of security and device configuration, refer to the
chapter entitled 'Security for your configuration' on page 54.

Before configuring a network connection manually, check whether one of the
available wizards might be applied to this purpose ('The wizards' on page 31).
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4.1.2

Considerations for setting up a wireless network

When designing networks for several access points, first determine where
the access points will be positioned and how far apart they will be from each
another. To ensure that the infrastructure of your wireless cells is free of
gaps, use a mohile computer and the AirLancer Client Manager to test the
wireless connections within the planned range. Use this method to measure
the maximum distance between the individual access points. Wireless gaps
between access paints are irrelevant where no workstations are planned or
network access does not have to be guaranteed.

Each access point spans its own wireless cell using a specific channel. In
most countries there are 13 available radiofrequencies, some of which how-
ever overlap. The actual number of channels on the ISM frequency band that
do not overlap are a maximum of three (e.g. channels 1, 6 and 13). This
means that no more than three access points within reach of a wireless LAN
can be operated completely free of interference; i.e. only three access points
per room or floor. A frequency or neighboring channel, naturally, can be used
again by other stations outside of the range.

When analyzing the network environment, the Site Monitor and Link Test
tools of the AirLancer Client Manager are very useful.

Refer to the appendix in this manual for a detailed list of frequency bands for
the individual channels.

Ad hoc network (peer-to-peer)

Define the direct connection between several computers in the configuration

profile using the Airlancer Client Manager.

@ Select the Add/Edit Configuration Profile command in the 'Action’
menu.

(@ Select and label one of the four profiles and specify 'Peer-to-peer group'
in the drop-down menu.

® Click Edit Profile and enter the name of the network. This name has to
be the same for all computers on the network.

You have now established the wireless bridge. You now have to set up a net-
work in order to access other computers.
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In Windows, set up Client for Microsoft Networks and file printer sharing
under the Network Neighbourhood properties. If you want to use TCP/IP as
your network protocol, be sure it is installed.

Infrastructure network

Define the wireless connection between the computers with Airlancer
MC-11 and the access point in the configuration profile using the AirLancer
Client Managers.

@ Select the Add/Edit Configuration Profile command in the 'Action’
menu.

(@ Select and label one of the four profiles and specify 'Access Point' in the
drop-down menu.

® Click Edit Profile and enter the name of the network. The name has to
be the same for each computer on the network and has to match the
name that has been assigned to the access poaint.

If you are creating an infrastructure network with more than one access point,
the roaming function is always available. Roaming guarantees the ability of
a mobile computer to switch from one wireless cell to another. The IAPP pro-
tocol has to be enabled for the access points so that the roaming computer
can be logged on and off of the various access points. You also have to set
the channel numbers at the access points (refer to page 50, ‘Considerations
for setting up a wireless netwark’). As the network name, you can enter
'‘ANY". This allows the roaming stations to log onto any nearby access point.
In this case, access at the access point has to be permitted for the network
name, 'ANY".

The corresponding menu commands are as follows:

WEBconfig:

Advanced configuration » Setup » WLAN module > IAPP protocol
and

Advanced configuration »> Setup » WLAN module > Closed net-
work

LANconfig:

» WLAN access > General > Roaming and
» Management ) Interfaces
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Point-to-point network

On a point-to-point network, two or more access points communicate with
each other. When configuring mobile stations, proceed exactly as you would
for setting up an infrastructure network. It is also possible to connect
point-to-point networks and infrastructure networks.

For the access points in this case, however, both the network name and the
radio frequency have to be the same and interpoint communication has to be
enabled. Furthermore, in the list of protocols you can only define the proto-
cols that are copied in the network. You can increase data throughput by
excluding any unneeded protocols.

The corresponding menu commands are as follows:
WEBconfig:

Advanced configuration »> Setup » WLAN module
LANconfig:

» Management ) Interfaces

» WLAN access > General > Point-to-point

Wireless Internet gateway via ISDN

For a wireless Internet gateway via ISDN, proceed on the client side exactly
as you would for setting up an infrastructure network.

Only a few steps are required to set up Internet access for all network users
via the integrated ISDN router. The easiest method to set up Internet access
is by using the setup wizard provided in Webconfig or LANconfig. You can
then fine-tune the settings manually in the individual router tables:

® Llayer list
The layer list contains predefined protocols, which you can customize as
needed (e.g. for channel bundling). The standard protocol is PPPHDLC,
which you can use in most cases. Here, assign a layer name for the ISDN
gateway. That defines it for the Internet connection to be configured.
® Name list
Data for remote stations and the phone numbers. Here, for example,
enter the Internet provider you call for an ISDN connection. The recom-
mended idle time is about 90 seconds. Apply the layer names that you
have created in the layer list.
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® PPP list
Here enter the device name and/or user name of the remote station and
the password for the connection. If the user name is different from the
device name, enter the user name here as well. Be sure that authentica-
tion is set to ‘None'. This refers to the local authentication of the remote
station. The LANCOM, not the provider, has to log on.

® IP router module
Here define the default route in the routing table. This should match the
device name defined in the name list. The IP address of the default route
is always 255.255.255.255 and the subnet mask is 0.0.0.0. The router
sends the data packets that are not intended for stations within the LAN
directly to the default route (such as an Internet provider).

The corresponding menu commands are as follows:
WEBconfig:

Advanced configuration > Setup » WAN module and
Advanced configuration > Setup » IP router module
LANconfig:

» Communication > Remote stations and Protocols
» IP router > Routing > Routing table

Wireless Internet gateway via DSL

The use of the LANCOM Wireless as a DSL router or DSL gateway is only pos-
sible if your provider uses the PPPoE protocol.

For a wireless Internet gateway via DSL, proceed on the client side exactly as
you would for setting up an infrastructure network.

Configure the following settings for the access point:

First you have to load the DSL firmware into the access point. Note that,
after doing so, the LAN interface will no longer be available! It then
functions as a DSL interface.

® Name list
Data for remote stations and the phone numbers. Here, for example,
enter the Internet provider you call for a DSL connection. The recom-
mended idle time is about 300 seconds. PPPoE is always used as the pro-
tocol and you will not find a layer list for the DSL settings.
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® PPP list
Here enter the device name of the remote station and the password. If
the user name is different from the device name, enter the user name
here as well. Be sure that no check is executed.

® IP router module
Here define the default route in the routing table. This should match the
device name defined in the name list. The IP address of the default route
is always 255.255.255.255 and the subnet mask is 0.0.0.0. The router
sends the data packets that are not intended for stations within the LAN
directly to the default route (such as an Internet provider).

Advanced configuration > Setup » WAN module and
Advanced configuration > Setup » IP router module
LANconfig:

» Communication > Remote stations and Protocols
» IP router > Routing > Routing table

Security for your configuration

A number of important parameters for the exchange of data are established
in the configuration of the device. These include the security of your network,
monitoring of costs and the authorizations for the individual network users.

Needless to say, the parameters that you have set should not be modified by
unauthorized persons. The ELSA LANCOM Wireless IL-11 thus offers a vari-
ety of options to protect the configuration.

Security for the device

Password protection

The simplest option for the protection of the configuration is the establish-
ment of a password. As long as a password hasn't been set, anyone can
change the configuration of the device.

The password input field can be found in the ELSA LANconfig in the 'Man-
agement' configuration section on the 'Security' tab. The password prompt
can be activated in a terminal or Telnet session in the / Set up/ Con-
fi g- modul e/ passw. requi red menu. Inthis case, the password
itself is set with the command passwd.
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Login barring

The configuration in the ELSA LANCOM Wireless IL-11 is protected against
“brute force attacks” by barring logins. A brute-force attack is the attempt of
an unauthorized person to crack a password to gain access to a network, a
computer or another device. In order to do so, a computer can, for example,
go through all the possible combinations of letters and numbers until the right
password is found.

As a measure of protection against such attacks, the maximum allowed num-
ber of unsuccessful attempts to login can be set. If this limit is reached, the
access will be barred for a certain length of time.

These parameters apply globally to all configuration options (outband, Telnet,
TFTP/ELSA [ANconfig and SNMP). These parameters apply globally to all
configuration options (Telnet, TFTP/ELSA LANconfigand SNMP). If barring is
activated on one port all other ports are automatically barred too.

The following entries are provided in the ELSA LANconfig for configuring
login barring in the '‘Management' configuration area on the 'Security' tab or
under / Set up/ Confi g- nodul e inthe menu:

® 'Lock configuration after' (Logi n errors)
® 'Lock configuration for' (Lock- mi nut es)

Access control via TCP/IP

Access to the internal functions of the devices through TCP/IP can be
restricted using a special filter list. Internal functions in this case refer to
configuration sessions via £LSA LANconfig, ELSA WEBconfig, SNMP or Tel-
net.

This table is empty by default and so access to the router can therefore be
obtained by TCP/IP from computers with any IP address. The filter is acti-
vated when the first IP address with its associated network mask is entered
and from that point on only those IP addresses contained in this initial entry
will be permitted to use the internal functions. The circle of authorized users
can be expanded by inputting further entries. The filter entries can describe
both individual computers and whole networks.

The access list can be found in ELSA LANconfig in the 'TCP/IP' configuration
section on the 'General' tab, or in the / Set up/ TCP-1 P- nod-
ul e/ Access-1i st menu.
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Security for your WLAN

The security of wireless data also can be guaranteed using various tech-
niques:

® Station filter

® Using a closed network

® Data encryption

You can also call up the wizards provided in WEBconfig or LANconfig to con-
figure the basic security settings.

Station filter

When defining an access list, specify which clients are allowed access to the
access point. Under the / Set up/ WLAN- nodul e/ Access- i st
menu item, add the MAC addresses of the card whose access is to be moni-
tored. Then, under the setting found under / Set up/ WLAN- nod-
ul e/ Access- node, you can define whether whether clients with these
card addresses have access (positive) or are not authorized (negative).

Closed network

On a closed network, the network name is not visible on remote stations.
Logging on using the 'ANY" network name is not possible in this case. There-
fore, all wireless stations on a closed network have to know the network
names and have them entered in their current user profiles.

Use the / Set up/ WLAN- nodul e menu to set the value for a closed net-
work to 'On’ (no access with 'ANY') or 'Off' (access with 'ANY" allowed).

Data encryption

The 11-Mbit wireless network cards support a data encryption based on the
WEP method (Wired Equivalent Privacy). The 'Security' tab in the Airlancer
Client Manager lets you define four different keys, based on how

® the data received and sent via wireless cards is decoded and

@ the data sent via wireless cards is encoded.

The four various keys can contain five alphanumeric characters from the
range 'a-z' and '0-9', whereby capitalization and lower case letters are distin-
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guished. As an alternative to the alphanumeric keys, a 10-digit hexadecimal
value can be assigned.

Alphanumeric key ‘ Hexadecimal key

For example: Seku1 ‘ For example: O0xABCD1234FE

In order to encode data communication, the same keys must be used for all
client stations and access points. Write down the assigned keys and store
them in a secure location.

The keys entered in the dialog box are only displayed when data is first input.
After closing the window, the values are protected from viewing via an
Xx-string.

Security for your LAN

You certainly would not like any outsider to have easy access to or to be able
to modify the data on your computer. A ELSA LANCOM Wireless IL-11 offers
various ways of limiting access for incoming and outgoing router connec-
tions:

® |P masquerading (also known as NAT/PAT)
® Data packet filtering
@ \Verification of incoming connections (callback to specified call numbers)

Firewall filter

The firewall filters of the LANCOM devices offer filter functions that can
apply to individual computers or the entire network. It is possible to set up
source and target filters for individual ports or port ranges. Furthermore, indi-
vidual protocols or any combinations of protocols (TCP/UDP/ICMP) can be fil-
tered.

As soon as a filter condition is met, a definable action can be triggered.

Two tables provide the means for setting up filters. The first, the object list,
is used to define computers, networks and protocols as objects. The second,
the rule list, is used to describe source, target and action based on individual
objects. The actual filter table is generated from these two tables.

As such, you do not need to create the filter list itself; and inconsistent
entries are thus prevented in the filter table.
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Object list

Rule table

Use the object list to define the objects to be filtered. The following may
apply as objects:

® Protocols

® |Individual computers
® Entire networks

® Services

Any and all of these elements may be combined. Furthermore, objects can be
defined recursively. In this manner, for example, you could define objects for
the TCP and UDP protocols. Later, objects such as those for FTP (= TCP + ports
20 and 21), HTTP (= TCP + port 80) and DNS (= TCP, UDP + port 53) could be
added. These in turn could be combined into a single object, which would
contain all permissions.

Use the rule table to combine individual objects into filter rules. The rule
table contains the protocol being filtered, the source object, the target object
and the filter action to be executed.

The protocol and the source and target objects can consist of combined
objects or contain direct descriptions (such as %P6 for TCP), which are sepa-
rated by '+ or the space character. Direct descriptions are labelled with '%'.
Possible descriptions include:

Description Function

%A IP address

%M Network mask

%S Service (port)

%L local net

%H Host name

%P Protocol (TCP/UDP/ICMP etc.)

Similar descriptions can form comma-separated lists, such as for host lists
and address lists (%A10.0.0.1, 10.0.0.2), or hyphened ranges, such as port
lists (%S20-25). Specifying '0' or an empty string indicates the 'ANY" object:

all computers: %A0.0.0.0
all services: %S0
all protocals: %P0
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Host names can be used only if LANCOM can resolve the names into IP
addresses. To do so, LANCOM has to have learned the names via DHCP or
NetBIOS, or the assignment has to be entered statically in the DNS or IP-rout-
ing table. An entry in the IP-routing table can simultaneously assign a host
name to an entire net.

The filter list is constructed of the object and rule lists. Indoing so, the union
of sets of all filters defined by the objects and rules is formed.

Note here that incorrect input neither results in a filter being created nor an
error message. When configuring filters manually, be sure to verify that the
filter you create does what you intend.

There are several ways of configuring firewall filters:
® WEBconfig
Full configuration » Setup » IP router module P> Firewall
® [ANconfig
IP router > Filter
® Telnet
/Setup/IP-router module/Firewall

ELSA [ ANconfig provides a very convenient tool for setting up filters. Use the
following 'Filter' index card to define filter rules.

Note that configuring filters using LANconfig modifies the form of object
tables that have been set up using Telnet or WEBconfig.

® General
Define here the name of the filter service and what is to happen with the
data packets (action).

® Stations
Define here the stations for which the filter rule is to apply as sender or
addressee.

® Services

Specify here which IP protocols and source and target ports the filter rule
applies to.

Security check

The “identifier” to be used for determining the caller can be specified in the
‘Communication’ configuration section under the 'Call Acceptance' tab, or
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under the / Set up/ WAN- nodul e/ Security menu. You have a
choice of the following:

@ All calls are accepted from any remote station.

® Name: Only calls from those remote stations entered in the name list are
accepted.

® Number: Only calls from those remote stations entered in the number list
are accepted.

® Name or number: Only calls from those remote stations entered in the
name list or number list are accepted.

It is an obvious requirement for identification that the corresponding informa-
tion is also sent by the caller.

Verification of When using the ELSA or PPP layer on the B channel, the name of the calling
hame party can also be transmitted. This requires a connection to be established
first, since the name cannot be transferred over the D channel.

The name of the remote station can also be transferred in PPP connections.

This requires a connection to be established first, since the name cannot be
transferred over the D channel.

The routers' response is obvious: Only those calls with recognized names are
accepted if protection by name is set; all others are rejected.

The name sent by the remote station will be checked for its appearance on
the PPP list of user names if the PPP protocol is being used. If the user name
is not available, the device name is accepted and verified as the name of the
remote station. The PPP list can be found in the ELSA LANconfigin the 'Com-
munication' configuration section on the 'Protocols’ tab, or in the
/ Set up/ WAN- modul e/ PPP- | i st menu.

Addition security is provided by a password. PPP offers password protection
through three different login protocols: PAP (Password Authentication Proto-
col), CHAP (Challenge Handshake Authentication Protocol) and MS-CHAP
(the Microsoft variation of CHAP). All of these protocols serve the same pur-
pose. The calling device determines which protocol is used.

cedures if you are using the LANCOM Wireless to dial up an Internet service
provider yourself, for example. You will probably not be able to persuade the
ISP to respond to a request for a password.

c Obviously you will not need to use the PAP, CHAP or MS-CHAP security pro-

And where do a caller's name and password come from?
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Checking the
number

In PPP connections, the name and password is sent to the remote station dur-
ing the call establishment, in the Dial-up Networking connection window for
example. The device name, password and user name in the PPP list are used
if the router establishes the connection itself.

Access to your own network is granted if the call number appears in the num-
ber list, or the caller is called back if the callback option is activated. If the
LANCOM Wireless is set to provide security using the telephone number, any
calls from remote stations with unknown numbers are denied access.

Callback

The callback function offers a special form of access privilege: This requires
the 'Callback’ option to be activated in the name list for the desired caller and
the call number to be specified, if required.

You can use the settings in the name and number list and the selection of the
protocol to control the callback action of your router:

® The router can refuse to call back.
@ It can call back using a preset call number.
® The caller can opt to specify the call number to be used for callback.

And all the while you can use the settings to dictate how the cost of the con-
nection is to be apportioned. The router accepts all unit charges, except for
the unit required to send the name, if call back "With name' is set in the name
list. Likewise, a unit is charged to the router, if the caller is not identified by
means of CLIP. On the other hand, the caller incurs no costs if identification
of the caller's number is possible and is accepted.

If the router is requested to call back, the Fast Call Back procedure (patent
pending) can be used with many other parties. This speeds up the callback
procedure considerably.

The hiding place—IP masquerading (NAT, PAT)

But this provokes objections from the network manager responsible for the
security of data on the company's network: Every workstation computer on
the WWW? Surely this means that anyone can get in from outside?—Not
true!

IP masquerading provides a hiding place for every computer while connected
with the Internet. Only the router module of the unit and its IP address are
visible on the Internet. The computers in the LAN then use the router as a
gateway so that they themselves cannot be detected. To do this, the router
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separates Internet and intranet, as if by a wall. Therefore, IP masquerading
is also called a “firewall function”.

For further information, see the 'IP routing: IP masquerading' section.

4.3 ISDN routing

Data communications between two ISDN terminal devices takes place via
ISDN connections. These connections can be realized either as dial-up or
leased-line connections.

Initially the router modules only determine the remote site to which a data
packet is to be sent. The various parameters for all required ISDN connec-
tions must be arranged so that a given connection can be selected and estab-
lished as required. These parameters are stored in a variety of lists, the
interaction of which permits the correct connections.

A simplified example will clarify this process.

Data packet with Internet user's PC
IP address J@
i}
L
===
= >
il ==y \iﬂf\eﬁ'f)
Provider A

P routing tab. | IP address
[ name of remote site

ISDN list Remote station
subscriber number, communication layer

PPP list Remote site
user name and password

A data packet from a computer initially finds the path to the Internet through
the IP address of the recipient. The computer sends the packet with this

( | ELSA LANCOM Wireless IL-lI |




| Operating modes and functions m)

4.31

address over the LAN to the router. Using the IP address, the router then
searches the IP routing table and finds the remote station that belongs to the
address, for example ‘Provider_A". Using this name, the router then checks
the ISDN name list and finds the call number for the corresponding remote
station that can be reached by ISDN, including the communication layer that
is to be used. The router also obtains the user name and password required
for login to Provider A from the PPP list.

When this is done, the router can establish a connection to the router of the
provider over the ISDN line. Once the connection has been established, the
router can forward the data packet to the Internet over the ISDN line.

You can find more information on IP networks, etc. in the technical documen-
tation provided on the CD.

The following sections introduce the ISDN name list and briefly describe the
parameters they contain, describe their connections to other lists and their
parameters, and how they are configured in the software.

For further information on the IP routing table, see the 'IP routing' section.

ISDN name list

The name list in the ELSA LANconfig can be found in the ‘Communication’
configuration section on the ‘Remote Stations' tab, or under
/ Set up/ WAN- modul e/ | SDN- nane- | i st during Telnet or termi-
nal sessions.

To define the available remote sites, enter them in the name list with a suit-
able name and additional parameters:
® Name
This name is used to identify the remote site in the router modules.
® Subscriber number
This number should be dialed when the router actively establishes a con-
nection to the remote station.

If the remote station can be reached under a variety of subscriber num-
bers, enter the other numbers in the round-robin list.

If the remote station is available via a leased line, the number for a
dial-up backup connection can be entered here.
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® Timeouts
These times indicate the length of time the B channels should remain
active after:
O the last data has been exchanged across static connections for the
holding time B1.

O the data throughput has dropped below a specified level for the hold-
ing time B2 in dynamic connections.

® layer name
The layer stands for a collection of protocols to be used for this connec-
tion. The layer must be set up identically on both sides of the connection.
® Callback
If the router receives a call from this specific remote station, it may be set
to refuse the connection. Instead, the remote station is called back using
the following options:
O Normal callback
O Callback using the fast ELSA process
O Callback after name verification

O Await the callback from the remote station using the fast ELSA pro-
cess

4.3.2 Interface settings

The interface settings for the £LSA LANconfig can be found in the 'Manage-
ment' configuration section on the ‘Interfaces’ tab, or under
/ Set up/ WAN- modul e/ I nt er face- i st during Telnet or termi-
nal sessions.

The overall parameters are set for each interface (i.e. each Sy port) in the
interface settings. These parameters apply to all operating modes of the
device. Specifically, they are:
@® D channel protocol used on the Sy port
Automatic recognition: DSS1 (Euro-ISDN), DSS1 point-to-point, 1TR6,
Group 0 leased-line connections
® leased line option
B channel to be used for the leased-line connection
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® Dialing prefix

Number to precede outgoing calls, e.g. the prefix for external calls when
using a PBX.

Router interface settings

The router interface settings for the £LSA LANconfig can be found in the
‘Communication’ configuration section on the 'General' tab, or under
/ Set up/ WAN- modul e/ Rout er -i nterface-1i st duringTel-
net or terminal sessions.

The router interface settings determine the parameters to be used for each
interface (i.e. each Sy port) while in router mode. These parameters do not
apply to the other operating modes of the units. Specifically, they are:

® Subscriber numbers (MSN/terminal device selection numbers)

The router responds to incoming calls for these numbers. Multiple num-
bers are separated by semicolons. If no subscriber number is specified,
the router will respond to all incoming calls.

The first subscriber number specified will be transmitted to the remote
station during the active establishment of a connection. If no number is
specified, the main MSN of the connection will be transmitted.

® Option for Y connections
Enable this option if it should be possible for both B channels of the con-
nection to establish parallel connections to different remote stations.

® Suppression of own subscriber number
Enable this option in order to suppress the display of your own subscriber
number to the remote station during call establishment.

This function must be supported by the network operator.

Layer list

The list of communications layers in the £LSA LANconfig can be found in the
‘Communication’ configuration section on the 'General' tab, or under
/ Set up/ WAN- modul e/ Layer - | i st during Telnet or terminal ses-
sions.

Alayer defines a specific combination of protocol settings to be used for data
transfer to other devices. Specifically, they are:

[ ELSA LANCOM Wireless IL-l | )




Cm Operating modes and functions

4.3.5

® layer name
The protocol settings will be saved under this name. In the name list,
select the settings with the layer name for the appropriate connection.
® Encapsulation
Specify here whether an Ethernet header should be added to the data
packets. Normally the setting ‘Transparent’ will be sufficient; this setting
may only be required for HDLC connections to third-party devices.
® layer-3
Layer-3 protocol for the connection. Recognized automatically in the
case of some incoming connections.
An additional entry is required in the PPP list when using PPP.
An additional entry is required in the scripts list when using scripts.
® layer-2
Layer-2 protocol for the connection.
® Options
Enables data compression and channel bundling. These options are only
effective when supported by the protocols of Layer 2 and Layer 3.
® layer-1
Layer-1 protocol for the connection. Recognized automatically in the
case of some incoming connections.

Call charge management

The capability of the router to automatically establish connections to all
required remote stations and close them again when no longer required pro-
vides users with extremely convenient access to the Internet, for example.
However, quite substantial costs may be incurred by data transfer over paid
lines if the router is not configured properly (e.g. in the filter configuration) or
by excessive use of the communications opportunities (e.g. extended surfing
in the Internet).

Settings in the charge module

The interface settings for the £LSA LANconfig can be found in the 'Manage-
ment' configuration section on the ‘Charges’ tab, or under
/ Set up/ Char ge- nodul e during Telnet or terminal sessions.
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The current charge and connect-time information is retained when rebooting
(e.g. when installing new firmware) is not lost until the unit is switched off.
All of the time values indicated here are in minutes.

Automatic address administration with DHCP

In order to operate smoothly in a TCP/IP network, all the devices in a local
network must have unique IP addresses.

They also need the addresses of DNS server and NBNS server as well as that
of a default gateway through which the data packets are to be routed from
addresses that are not available locally.

In a smaller network, it is still conceivable that these addresses could be
entered manually in all the computers in the network. In a larger network with
many workstation computers, however, this would simply be too great.

In such situations, the DHCP (Dynamic Host Configuration Protocol) is the
ideal solution. Using this protocol, a DHCP server in a TCP/IP-based LAN can
dynamically assign the necessary addresses to the individual stations.

The DHCP server

As a DHCP server, the ELSA LANCOM Wireless IL-11 can administer the IP
addresses in its TCP/IP network. In doing so, it passes the following param-
eters to the workstation computers:

IP address

Netmask

Broadcast address

DNS server

NBNS

Default gateway

Period of validity for the parameters assigned

The DHCP server takes the IP addresses either from a freely defined address
pool or determines the addresses automatically from its own IP address (or
intranet address).

In DHCP mode, a completely unconfigured device can even automatically
assign IP addresses to itself and the computers in the network.

In the simplest case, all that is required is to connect the new device to a net-
work without other DHCP servers and switch it on. The DHCP server then
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interacts with £LSA [ ANconfig using a wizard and handles all of the address
assignments in the local network itself.

442 DHCP—'on’, 'off' or 'auto'?

The DHCP server can be set to three different states:

® ‘on": The DHCP server is permanently active. The configuration of the
server (validity of the address pool) is checked when this value is entered.

O When carrectly configured, the device will be available to the net-
waork as a DHCP server.

O In the event of an incorrect configuration (e.g. invalid pooal limits), the
DHCP server is disabled and switches to the 'off' state.

® ‘'off': The DHCP server is permanently disabled.
® ‘auto’: The server is in automatic mode. In this mode, after switching it
on, the device looks for other DHCP server within the local network.

O The device then disables its own DHCP server if any other DHCP serv-
ers are found. This prevents the unconfigured device from assigning
addresses not in the local netwark when switched on.

O The device then enables its own DHCP server if no other DHCP serv-
ers are found.

Whether the DHCP server is active or not can be seen in the DHCP statis-

tics.

The default state is 'auto’.

4.43 How are the addresses assigned?

IP address assignment

Befare the DHCP server can assign IP addresses to the computers in the net-
waork, it first needs to know which addresses are available for assignment.
Three options exist for determining the available selection of addresses:

® The IPaddress can be taken from the address pool selected (start address
pool to end address pool). Any valid addresses in the local network can
be entered here.

@ It then uses the IP address '10.0.0.254" for itself and the address pool
"10.x.x.x" for the assignment of IP addresses in the network. In this state,
the DHCP server only assigns IP addresses and their validity to the com-
puters in the network, but not the other information.
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If only one computer in the network is booted and requests an IP address via
DHCP with its network settings, a device with an activated DHCP module will
assign this computer an address. A valid address is taken from the pool as
an IP address. If the computer was already assigned an IP address at some
point in the past, it requests this same address and the DHCP server attempts
to reassign it this address if it has not already been assigned to another com-
puter.

The DHCP server also checks whether the address selected is still available
in the local network. As soon as the uniqueness of an address has been
established, the requesting computer is assigned the address found.

Subnet mask assignment

The network mask is assigned in the same way as the address. If a network
mask is entered in the DHCP module, this mask is used for the assignment.
Otherwise, the network mask from the TCP/IP module is used.

Broadcast address assignment

Normally, an address yielded from the valid IP addresses and the network
mask is used for broadcast packets in the local network. In special cases,
however (e.g. when using subnetworks for some of the workstation comput-
ers), it may be necessary to use a different broadcast address. In this case,
the broadcast address to be used is entered in the DHCP module.

The default setting for the broadcast address should be changed by experi-
enced network specialists only.

DNS and NBNS assignment
This assignment is based on the associated entries in the 'TCP-IP module'.

If no server is specified in the relevant fields, the router passes its own IP
address asa DNS address. This address is determined as described under 'IP
address assignment’. The router then uses DNS-forwarding (also see
'DNS-forwarding'), to resolve DNS or NBNS requests from the host.

Default gateway assignment

The device always assigns the requesting computer its own IP address as a
gateway address.

If necessary, this assignment can be overwritten with the settings on the
workstation computer.
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Period of validity for an assignment

The addresses assigned to the computer are valid only for a limited period of
time. Once this period of validity has expired, the computer can no longer use
these addresses. In order for the computer to keep from constantly losing its
addresses (above all its IP address), it applies for an extension ahead of time
that it is generally sure to be granted. The computer loses its address only if
it is switched off when the period of validity expires.

For each request, a host can ask for a specific period of validity. However, a
DHCP server can also assign the host a period of validity that differs from
what it requested. The DHCP module provides two settings for influencing
the period of validity:

® Maximum lease time in minutes
Here you can enter the maximum period of validity that the DHCP server
assigns a host.

If a host requests a validity that exceeds the maximum length, this will
nevertheless be the maximum available validity!

The default setting is 6000 minutes (approx. 4 days).

® Default lease time in minutes

Here you can enter the period of validity that is assigned if the host
makes no request. The default setting is 500 minutes (approx. 8 hours).

Priority for the DHCP server—request assignment

In the default configuration, almost all the settings in the Windows network
environment are selected in such a way that the necessary parameters are
requested via DHCP. Check the settings by clicking Start > Settings »
Control Panel > Network. Select the 'TCP/IP' entry for your network
adapter and open Properties.

Check the various tabs for special entries, such as for the IP address or the
standard gateway. If you would like all of the values to be assigned by the
DHCP server, simply delete the corresponding entries.

Priority for a workstation—overwriting an assignment

If a computer uses parameters other than those assigned to it (e.g. a different
default gateway), these parameters must be set directly on the workstation
computer. The computer then ignores the corresponding parameters
assigned to it by the DHCP server.
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This can be performed via the Network Neighborhood properties, for exam-
ple.

Click Start > Settings > Control Panel » Network. Select the 'TCP/IP'
entry for your network adapter and open Properties.

You can now enter the desired values by selecting the various tabs.

The assignment of IP addresses to the various computers can be checked
using the 'Setup/DHCP/Table-DHCP" item in the DHCP module. This table
contains the assigned IP address, the MAC address, the validity, the name of
the computer (if available) and the type of address assignment.

The 'Type' field specifies how the address was assigned. This field can

assume the following values:

® new
The computer has made its initial request. The DHCP server verifies the
uniqueness of the address that is to be assigned to the computer.

® unknown
While verifying uniqueness, it was determined that the address has
already been assigned to another computer. Unfortunately, the DHCP
server has no means of obtaining additional information on this com-
puter.

® status
A computer has informed the DHCP server that it has a fixed IP address.
This address can no longer be used.

® dynamic
The DHCP server assigned an address to the computer.

Configuring the DHCP server

Basically, two starting points are possible when the devices are configured
as a DHCP server:

® You have not yet configured a network or your existing local network
does not use TCP/IP. The DHCP server in your new ELSA lets you assign
IP addresses to all of the computers in the network and to the router in a
single operation.

® You are already using TCP/IP but without a DHCP server, and you would
now like to convert to DHCP operation.
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Configuration using ELSA LANconfig and the wizards
The ELSA LANconfigincludes a wizard to help you with the required settings:

@ Connect the unconfigured device to your local network using a network
cable.

(@ Switch the device on. It will not find any other DHCP servers in the net-
work and will thus enable its own DHCP functions.

® Ifyou have not done so already, install the TCP/IP protocol on all comput-
ers in the LAN.

O Usually when the protocol is installed, the default configuration is
such that the computers are automatically ready to obtain the IP
address from a DHCP server. After rebooting at the end of the proto-
col installation, the computers automatically request an IP address
from the DHCP server.

O If the protocol is already installed, enable the DHCP function on all of

the computers in the local network. Under Windows 95, for example,
thisis done by selecting Start p> Settings > Control Panel > Net-
work to open the window for configuring network properties. Dou-
ble-click the entry for the 'TCP/IP' protocol.
Enable the 'Obtain an IP address automatically' option. Switch over
to the 'DNS Configuration' tab and delete all of the existing DNS
addresses. Next, delete any entries under the ‘Gateway' tab and click
OK to close all the windows. This change will require a reboot, after
which the computer will automatically request an IP address from the
DHCP server's address pool.
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TCPAP Properties

Bindings | Advanced | NetBl0s | a

DMS Configuration I Giateway | WINS Configuration | Address

An P address can be automatically assigned to this computer.
If your network, does not automatically assign IP addresses, azk
ywour network, administrator for an address, and then type it in
the space below.

" Obtain an P address automatically

= Speciiy an [P address:

Ok I Cancel |

@ Install the ELSA LANconfig on a computer in the network.

(® Start the program from the 'ELSAlan' program group. When loading, the
ELSA LANconfig will detect an unconfigured router in the network and
will launch the wizard for the basic settings.

O If you have not previously used any IP addresses in your network,

select the option ‘Make all settings automatically" in this wizard and
confirm your selection with Finish in the next window.
The wizard assigns the IP address '10.0.0.1" with the netmask
'255.255.255.0" to the router and enables the DHCP server. On the
basis of this IP address, the device then determines the valid address
pool for the DHCP assignment.

O In the event that IP addresses were already in use in your network
before converting to DHCP operation, select the option 'l would like
to adjust the settings manually' in the wizard. In the next window,
enter an unused IP address from the previously-used address range
and activate the DHCP server.

The wizard now assigns the selected IP address and associated net-
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mask to the device. On the basis of this IP address, the device then
determines the valid address pool for the DHCP assignment.

O After a few seconds, all of the computers in the network will be
checked and are assigned a new IP address by the DHCP server as
required. The computers also receive additional parameters such as
the broadcast address, DNS server, default gateway, etc.

Manual configuration

If configuration using the ELSA LANconfig wizard is not for you, set the
parameters for the DHCP server manually: In ELSA LANconfig in the "TCP/IP'
configuration section on the 'DHCP' tab or in the / Set up/ DHCP- nod-
ul e menu).

The least-cost router

The liberalization of the European telecommunications market has led to the
availability of a variety of providers (network operators) that often offer a
wide range of different charges. These providers also provide the option of
the preselection of a given network or the placement of long-distance calls
on a call-by-call basis without a contract with a specific provider. The prefix
of the provider must be dialed to access the desired netwark on a call-by-call
basis. The normal telephone number is dialed after the network identifica-
tion prefix.

Unfortunately, the most inexpensive rates vary from provider to provider
depending on the time of day and region. In the morning Provider 1, Provider
2 in the afternoon and possibly Provider 3 for international calls. To always
have the most economical connection for telephone calls, surfing the Internet
or transferring data to other networks, it would be necessary to decide which
provider is the least expensive before each connection. A ELSA LANCOM
Wireless IL-11 does this for you. Least-cost routing (LCR) is the function for
this task. You define once which providers have the most favorable charges
for your purposes, and the device automatically selects the most economical
provider for you, (regardless of whether you are using the router, the LAN-
CAPI etc.).

Function of the LANCOM Wireless least-cost router

The LCR analyzes the digits dialed by the router or LANCAPI.

The unit checks the LCR table after each digit for a correspondence to a pre-
viously dialed number (prefix). If a suitable entry is found which is even valid
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for the current time and date, the network identification prefix for the connec-
tion's detour will be entered before the area code. The number is not sent
out to the exchange until it has been completed in this manner.

The LCR also requires the following information:

® A dialing prefix (area code) to determine which calls are possible for a
detour.

® One or more network identification prefixes to determine the provider to
be used for this prefix.

® The days of the week and holidays for which the entry is valid.

® The time of day for which the entry is valid.

Initial tests

It's possible to achieve a considerable savings with only a few entries. We
would like to describe the programming of the LCR using this simple example.

You know, for example, that considerable savings can be had by selecting a
provider on a call-by-call basis for long distance and international calls. You
have also checked the rates of a number of call-by-call (CbC) providers and
selected the most economical ones. The first entries in the LCR table will
then appear as follows:

Dlal_mg ChC network prefix Days of week Time of day

prefix

0117 4 Sat + Sun 0:00 AM to 11:59 PM

0117 0800-PIN Mon + Tue + Wed + Thu +  8:00 AM to 6:00 PM
Fri

00 4 Sun 0:00 AM to 11:59 PM

These four entries mean that all connections to Munich (or other numbers
with the prefix '089') on weekends will be made using the provider with the
network prefix '01097'. Between 8:00 AM and 6:00 PM on weekdays, these
calls will be made using the provider with the network prefix '0800'". Interna-
tional calls on Sundays will be made using the provider with the network pre-
fix '4'.
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For advanced users: systematic use of the LCR

® The first example has shown how connect charges can be reduced with
only a few entries. If youwould like to put the least-cost router to optimal
use, detailed information is required with regard to the connect-charge
structure of the call-by-call providers. Next, decide how these rates and
rate zones can be best organized in the ELSA LANCOM Wireless IL-11
LCR table. Avariety of approaches are possible:

® Obvious options for saving telephone charges can be entered directly:
O '00' for international connections

® Entering a single ‘0" will initially reroute all numbers starting with a zero.
However, as neighboring local exchanges may also start with a ‘0" and
yet be billed as local calls, their prefixes should be listed separately to
prevent these calls from being rerouted. This strategy should also be
applied to special prefixes such as '0800" etc.

® Another strategy aims to achieve the highest possible level of control
over the routing activities. Start with the prefixes of the local area and
then define the next larger zones. The closer, and thus less expensive,
tariff zones are set with longer prefixes, the remaining more distant pre-
fixes with a smaller number of digits.

This setting can be expanded and refined as required. Here are a number of
further ideas for your consideration:

® An area code is required to dial a number of local exchanges, but these
calls may be billed as local. If these areas have been routed using a gen-
eral entry, you could route the area codes that are billed as local calls via
the network prefix of your telephone company If the entry for the network
prefix is left empty, the entry will not be rerouted.

® Perhaps a large number of your ISDN connections go to the same area
codes. If most of your remate stations are in Bristol, for example, you can
reach these numbers using a specific provider.

@ Study the various tariff zones. Check the Internet for the assignments of
area codes to zones. In Germany, for example, this is possible at:
‘www.cheap-calls.com'.

Once you have found the area codes that you would like to reroute, you can
start assigning them to call-by-call providers. For this, you need the current
rates of as many telephone providers as possible. These can also be found
in the Internet.  Addresses such as ‘www.cheap-calls.com' (or
‘www.focus.de' in Germany), for example, contain complete, up-to-date list-
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ings for all types of connections. With this information on hand, you can now
begin feeding your least-cost router...

Setting up the least-cost router

Two essential questions must be clarified with regard to configuring the
least-cost router:

® Which operating modes of the ELSA LANCOM Wireless IL-11 should the
services of the least-cost router use?

® Which calls should be routed over which provider?
To answer these questions, proceed as follows:

@ In ELSA L ANconfig, go to the 'Least-cost router' configuration section on
the 'General’ tab.

(@ Enable the least-cost router function. The least-cost router can only be
enabled if you have already set the unit time manually or the time has
already been received from the ISDN network itself (see also ‘Time for
the Selection' further below). Activate the following operating modes for
the least-cost router as required:

O Router
O LANCAPI

If you have also activated least-cost routing for the router module, connec-
tions may be established via providers that do not transmit connect-charge
information. The connect-charge monitoring may thus be inadvertently lost.
In this case, use the time budget as an alternative.

® Change over to the 'Time periods and public holidays' tab. Open the
Least-cost table, create a new entry and enter the following data:

O Which prefix should be rerouted?

O Which provider should be used for this prefix? If you have entered
several network prefixes separated by semicolons, the LCR will auto-
matically try the next prefix if the current ane is busy.

O 0On which days and what times should the routing be active? Please
note that time blocks cannot extend from one date to another (i.e.
6:00 p.m. to 6:00 a.m.).

O Should the call be handled by the default telephone provider if all
call-by-call providers are busy? If 'Automatic Fallback' is disabled,
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the LCR will start at the beginning after unsuccessfully trying the last
network prefix.

Least-cost table - New Entry EHE
Forward this prefis: 030
To Call-by-Call number: ID‘I 3 Cancel |
V' Mondays V' Tuesdays
V ‘wednesdays V' Thursdays
V' Fridays ™ Saturdays
™ Sundays ™ Public holidays
Start time: IS 00 P 3:

End time: 12 :00 =
¥ Automatic falback if no connection can be established to the
zelected call-by-call numbers

@ Ifyou have also made entries in the LCR table for holidays, open the Pub-
lic holidays list. Enter each holiday with its full date (DD.MM.YYYY).

(® Check the internal clock of the unit (incl. the date), to ensure that the LCR
activates the routing at the correct time (see also ‘Time for the Selection’
further below).

Build the LCR table one step at a time and check your results. Open the ELSA
LANmanitor, for example, and establish connections to the remote stations
to be rerouted according to the table using the ELSA LANCAPI. Use the dialed
number to verify whether the LCR settings suit your requirements. For router
connections, check the log file for the number dialed (LANmonitor: View »
Options » Protocol » Display).

Time for the selection

It goes without saying that the internal clock of the ELSA LANCOM
Wireless IL-11 must be set properly to ensure that the least-cost router cor-
rectly applies the information in the table. The router can also help itself in
this respect as well, however: It can synchronize its internal clock with the
time in the ISDN, either when switched on, or during each call establishment.

@ In ELSA [ ANconfig, switch to the 'Date/Time' tab in the 'Management'
configuration section.

(@ Activate the option for automatic synchronization at each call establish-
ment. If you would rather enter the time manually, disable this option.
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® The current time is lost when the unit is switched off. Enter the number
of a random remote station if you would like the device to establish a con-
nection immediately upon being switched on, in order to synchronize the
time with that of the ISDN network. Specify whether the remote station
is digital (e.g. BBSs or Internet providers) or analog (telephone message
or voice services).

AACHEN Configuration EHE

Configure: I M anagement = l

Generall Interfacesl Securityl Charging Date/Time | SNMF’I

— Date and Time

¥ Setthe devies's clock to ISDN time whenever a
connection is made

If you want the device to set up a connection in order to zet the
time whenever it is switched on, enter the relevant telephone

number here.
Fhone number: |1 23456999
Type of the remate site: IDigitaI 'l
()8 Cancel |
Lo

Please check the time after the first connection. Some PBXs may transfer
incorrect times to the router, which would impair the function of the
least-cost router!

ELSA CAPI Faxmodem

The ELSA CAPI Faxmodem provides a Windows fax driver (Fax Class 1) as an
interface between the £ELSA LANCAPI and applications, permitting the use of
standardfax programs with an ELSA LANCOM Wireless IL-11.

Installation

The ELSA CAPI Faxmodem can be installed from the CD setup. Always install
the ELSA CAPI Faxmoadem together with the current version of ELSA LAN-
CAPI. After restarting, the ELSA CAPI Faxmodem will be available to your
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system. Under Windows 95 or Windows 98, it can be found under Start »
Control Panel » Modems.

Faxing with the ELSA CAPI Faxmodem

Most major fax programs recognize the ELSA CAPI Faxmodem automatically
during installation and identify it as a ‘Class 1' fax modem. Fax transmissions
can thus be realized at speeds of up to 14,400 bps. If your fax program offers
you a choice (such as WinFax and Talkworks Pro), select the option 'CLASS 1
(Software Flow Control)' when setting up the modem.

The ELSA CAPI Faxmoadem requires ELSA LANCAP! for the transmission of fax
messages. A small CAPl icon in the lower right corner of your screen confirms
that LANCAPI is enabled. Please also take care with the settings of the LAN-
CAPI itself.

Office communications and LANCAPI

LANCAPI from ELSA is a special version of the popular CAPI interface. CAPI
(Common ISDN Application Programming Interface) establishes the connec-
tion between ISDN adapters and communications programs. For their part,
these programs provide the computers with office communications functions
such as a fax machine or answerphone.

This chapter briefly introduces you to LANCAPI and the accompanying appli-
cation programs for office communications as well as providing you with
instructions that are important for installing the individual components.

LANCAPI interface settings

The LANCAPIinterface settings for the ELSA LANconfig can be found in the
'LANCAPI" configuration section on the 'General' tab, or under
/ Set up/ LANCAPI - nodul e/ I nt erface-1i st during Telnet or
terminal sessions.

Use the router interface settings to determine the parameters to be used for
each interface (i.e. each Sy port) for the LANCAPI. These parameters do not
apply to the other operating modes of the units. Specifically, they are:

® Subscriber numbers (MSN/terminal device selection numbers)

The LANCAPI responds to incoming calls for these numbers. Multiple
numbers are separated by semicolons. If no subscriber number is speci-
fied, the router will respond to all incoming calls.
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® Access to LANCAPI

Here you can completely disable the LANCAPIfunctions for the interface,
or enable it only for incoming or outgoing calls.

® Transfer of own subscriber number
Normally the number specified in the CAPI application is transferred to
the remote station via the LANCAP! during active call establishment. No
number is transferred by the LANCAP/if this number has not been spec-
ified or the number is invalid. This option lets you transfer the first num-
ber entered in the 'Subscriber Number' field if no number has been
specified in the CAPI application.

The ELSA LANCAPI

What are the advantages of LANCAPI?

For example, faxes are sent by simulating a fax machine at the workstation.
With the LANCAPI, the PC forwards the fax via the network to the router
which establishes the connection to the recipient.

Installing the LANCAPI client

The LANCAPI is made up of two components, a server (in the ELSA LANCOM
Wireless IL-11) and a client (on the PCs). The LANCAPI client must be
installed on those computers in the LAN that will be using the LANCAPI func-
tions.

@ Place the ELSA LANCOM CD in your CD-ROM drive. If the setup program
does not automatically start when you insert the CD, simply click ‘auto-
run.exe' on the ELSA LANCOM CD in the Windows Explorer.

@ Select the 'Install LANCOM software' entry.

® Highlight the 'ELSA LANCAPI' option. Click Next and follow the instruc-
tions for the installation routine.

If necessary, the system is restarted and LANCAP/is then ready to accept all
jobs from the office communications software. After successful installation,
an icon for LANCAPI will be available in the Start menu. A double-click on
this icon opens a status window that permits current information on the LAN-
CAPIto be displayed at any time.
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Configuring the LANCAPI client

The configuration of the LANCAPIclient is used to determine which LANCAPI
servers will be used and how these will be checked. All parameters can
remain at their default settings if you are using only one ELSA LANCOM
Wireless IL-11 in your LAN as a LANCAP! server.

@ Start the LANCAPI client in the 'ELSAlan' program group. Information
regarding the drivers for the available service can be found on the 'Gen-
eral' tab.

(@ Switch to the 'LANCAPI Server' tab. First, select whether the PC should
find its own LANCAPI server, or specify the use of a particular server.

O For the former, determine the interval at which the client should
search for a server. It will continue searching until it has found the
number of servers specified in the next field. Once the required num-
ber of servers has been found, it will stop searching.

O In the event that the client should not automatically search for serv-
ers, list the IP addresses of the servers to be used by the client. This
can be useful if you are operating several ELSA [ANCOM
Wireless IL-11 in your LAN as LANCAPI servers and you would like to
specify a server for a group of PCs, for example.

O It is also possible to set the interval at which the client checks
whether the found or listed servers are still active.
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General LAMCAP| Server | a

& dutomaticly search for LANCAP] servers

Search for servers every IBD _I::' seconds

Don't uze more than |1 _,::‘ zerverz]

— € Use anly the LANCAP| servers specified here

fdld Edgt | [ oeee |

LCheck availability of a server every (10 _:l zeconds

oK I Cancel Lapply

Configuring the LANCAPI server

Two basic issues are important when configuring the LANCAPI server:

® What call numbers from the telephone network should LANCAPI respond
to?

® Which of the computers in the local network should be able to access the
telephone network via LANCAPI

Set the relevant parameters as follows:

@ Start ELSA [ANconfig which can be found in the 'ELSAlan' program
group. Open the configuration of the router by double-clicking on the
device name in the list and select the 'LANCAPI' section.
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AACHEN Configuration EHE

Configure: I LAMCAF = l

General | Availabilty |

LAMCAP] server: of =

Mumber [MSHELZ): I‘I 23456
Fart nurnber: |?5

Thiz iz where you should specify the stations which are to have
access if you wizh to restrict access to server. All stations will have
access ag long as this list remaing blank.

Acocess list ..

()8 I Cancel |

(@ Activate the LANCAPI server, or set it to permit outgoing calls only. Inthe
latter case, the LANCAPI will not respond to incoming calls—to receive
faxes, for example. Permitting outgoing calls only is useful if you do not
have a specific call number available for the LANCAPI.

(® When the LANCAPI server is activated, enter the call numbers to which
the LANCAPIshould respand in the ‘Number field. You can enter several
call numbers separated by semicolons. If you do not enter a call number
here, all incoming calls are reported to LANCAPI

@ LANCAPIis preset to use port '75' (any private telephony service). Do not
change this setting unless this port is already in use by a different service
in your LAN.

® If you do not wish all the computers in the local network to be able to
access the LANCAPIfunctions, you can define all the autharized users (by
means of their IP addresses) by entering them in the access list.

If you enter more than one call number for the LANCAPI, you can, for example,
provide each individual workstation with a personal fax machine or personal
answering machine. Proceed as follows: When installing communications
programs such as ELSA-RVS-COM on the different workstations, specify the
various call numbers to which the program should respond.
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Switch to the ‘availability' tab. Here you can determine how the £LSA LAN-
COM Wireless IL-11 should respond if a connection is to be established via
the LANCAPI (incoming or outgoing) when both B channels are already busy
(priority control). The available options are:

AACHEN Configuration EHE

Configure: I LAMCAF = l

General Availability |

If you want to establizh a connection but no lines are free:

& ‘other connections will not be intermupted. ou cannot establish
ia connection,

" if possible, a secondary router channel will be interupted so
that a line iz made available.

" if possible, a secondary or a primary router channel will be
interrupted so that a line iz made available.

()8 ﬂ Cancel |

@ The connection cannot be established via the LANCAPI. A fax program
using the LANCAPI will then probably attempt to send again at a later
time.

® The connection via the LANCAPI can then be established when a main
channel is free. A main channel is the first B channel used when a router
connection is established. Secondary channels are used for channel bun-
dling.

@ A connection can always be established via the LANCAPL an existing
router connection will be terminated for the duration of the call if
required. This can be used to ensure the permanent availability of the fax
function, for example.

Using the LANCAPI
Two options are available for the use of the LANCAPI:
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4.8

You may use software which interacts directly with a CAPI (in this case,
the LANCAPI) port, such as ELSA-RVS-COM. This type of software
searches for the CAPI during its installation and uses it automatically.
Other programs such as Laplink can establish a variety of connection
types, for example, using Windows Dial-up Networking. You may select
the installed communications device that you would like to use when cre-
ating a new dial-up connection. For the LANCAPI, select the entry 'ISDN
WAN Line 1".

Accounting

The accounting tool determines online times and data transfer volumes and
breaks them down according to the computers that used the connections.
The accounting data are stored in a list for current connections and in an
accumulated list.

The data collected include the following:

User (name, IP address, MAC address)

The online times and data transfer volumes are assigned the MAC
addresses of the system network interfaces in the LAN. The router can
supply additional information regarding the assignments of MAC
addresses and computer names from the DHCP or DNS server modules,
if available. In this case, online times can be assigned directly to com-
puter names. If the assignment of MAC addresses to computer names is
not possible, other existing information is recorded to identify the user,
such as the IP address.

Usually the MAC address cannot be determined for network users who
access the LAN via dial-in connections. In this case, the router generates
a pseudo address that allows the remote dial-in stations to be identified
during accounting.

Remote site to which the connection was established
Type of connection

Sent and received data volumes

Online time

The entire connection time of a dial-up connection that is used by several
users at a time can be longer than the amount of time a user actually uses
it. So in such cases, the length of the connection is determined based on
the first and last user actions plus the valid hold time for the connection.
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4.8.2

® Number of connections

This field specifies how often a user's action led to the establishment of
a connection.

Configuring accounting

Settings for accounting are found under / Set up/ Account i ng. From
there, you can enable or disable accounting and enable storage to flash ROM.
Furthermore, you can influence the sorting of the accumulated table based
online time or transfer volume.

Reading the accounting data

ELSA LANmonitor provides the means of viewing the listed data. It also
allows you to save the data to a file on a drive.

% LANCOM Wireless IL-11 - Accounting Information

Accouniing
User [RemoteSte | Tupe T Connections | Freceived | Transmitied [
EpKNowsk Intermet ‘wiahlverb, (DSL) 23 316918KE 3KB
1921681.1 Intemet Wahbverb, [DSLY 10 560.307 KB 453K8
Windows FC1 Kiowak Wahlverb. [SDN) ) 4KB 2288 K8
= windowsPC2 KNowak wahiverb (ISDN) a 121 KB

The listed data can also be called up using Telnet access under
/ Set up/ Account i ng.

Organized by user name and remote site, the following information is listed:
® Username

The name of the user or his or her layer-3 address (IP address, IPX address
or, in bridge mode, the MAC address again)

® Remote site

The remote site with which the user exchanged data
® Connection type

Type of connection
® Rx-bytes, Tx-bytes

Data volumes on the interface
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® Total amount of time
Total online time for this user to this remote site
® Connections
The number of counted connections for this user to this remote site
If a user establishes a connection to another remote Site, a new entry is cre-

ated in the table. All of the transfer volumes and online times incurred by one
user to one remote Site are recorded in a single entry.

=O

Depending on how the list is sorted, the 512 entries with the largest transfer
volumes or longest online times are included in the table.
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Technical data

Power and ratings data

Frequency band-
width

Standard

Transfer through-
put

Range

Bit error ratio

Transmitting
power

Radio channels

Network proto-
cols

ISDN

Security

Connects

Package contents

2400-2483.5 MHz (ISM)

IEEE 802.11b, DSSS (Direct Sequence Spread Spectrum)

High: 11 Mbps

Medium: 5,5 Mbps

Standard: 2 Mbps

Low: 1 Mbps

The transmission rate is automatically determined. Itis also possible
to adjust the transmission rate manually.

About 150-400 meters across open terrain and about 30-50 meters in
closed buildings (typical range)

Better than 10
15 dBm

Up to 13 channels, max. 3 non-overlapping

Any network protocols can be transmitted between wireless LAN and
ethernet LAN by bridge; protocols for WAN: PPP/MLPP (ISDN), PPPoE
(DSL); routed protocols via ISDN/DSL: TCP/IP, IPX, NetBIOS/IP, LANCAPI
(virtual CAPI 2.0)

ISDN-Sg bus, DSS1, 1TRB, autosense, optional fixed line available,
CAPI server

Password protection, address and protocol filters: WEP encryption, Clo-
sed Wireless Network, IP masquerading (NAT/PAT), firewall filters

10-base-T, ISDN Sy, external power adapter (9V)

— Extensive documentation in German, English, French and Italian
— Patch network cable (UTP)

— ISDN S, cable

— Plug-in power adapter

— Software bundle CD with ELSA RVS-COM, Laplink Pro

— (D with management software
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Standards/ ETSI, ETS 300328, ETS 300826, EN 55022, EN 55024, EN 60601-1-2,

Approvals EN 60950, CE marked; radio approval for all EU countries and Switzer-
land

Warranty ‘ 6 years for the access point, 2 years for the AirLancer wireless adapter

Support ‘ Hotline and Internet, free software updates
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Radio frequency channels

Up to 13 DSSS channels are available within the utilizable frequency range a
of 2400 to 2483 MHz. Each channel has a bandwidth of 22 MHz, so that a
maximum of three independent channels are possible within the ISM fre-

quency band. Not all channels are utilizable in all countries. The following

table shows the medium frequencies and what channels are permitted in

what country.

Frequency band | 2400-2500 MHz

Channel no. USA (FCC) EU (ETSI) France * Japan
1 2412 2412 - 2412
2 2417 2417 - 2417
3 24722 24722 - 24722
4 2427 2421 - 2427
5 2432 2432 - 2432
6 2437 2437 - 2437
7 2442 2442 - 2442
8 2447 2447 - 2447
9 2452 2452 - 2452
10 2457 2457 2457 2457
" 2462 2462 2462 2462
12 - 2467 2467 2467
13 - 2472 2472 2472

* In France, the entire ISM band will be cleared for use by radio networks by 2001. Please
read the information on this provided in the 'Readme’ file on the CD.

The boldface values are set as the defaults for the ELSA LANCOM Wireless IL-11.

[ ELSA LANCOM Wireless IL-l | )




(BEZA Technical data |

( | ELSA LANCOM Wireless IL-lI |




| Appendix m

6 Appendix

6.1 Declaration of conformity

q3

KONFORMITATSERKLARUNG

gemaR dem Gesetz iiber F und i
(FTEG) und der Richtlinie 1999/5/EG (R&TTE)

EC- DECLARATION OF CONFORMITY appropriate to the law of radio and telecom terminalequipment and
Directive 1939/5/EC (R&TTE)

Die Firma: ELSA AG
The Company: Sonnenweg 11
52070 Aachen
erklart, daB das Produkt: ELSA LANCOM Wireless IL-11

declares that the product:
Telekommunikations (TK-) Endeinrichtung
telecommunications terminal equipment radio equipment

Verwendungszweck: Router
intended purpose

den grundlegenden Anforderungen des & 3 und den iibrigen einschldgigen Bestimmungen des FTEG

(Artikel 3 der R&TTE) entspricht.

complies with the appropriate essential requirements of the FTEG (Article 3 of R&TTE) and the other relevant provisions.
Harmonisierte Normen: Gesundheit und Sicherheit gemaRB 83 (1) 1. (Artikel 3 (1) a))
Harmonised Standards: Health and Safety requirements contained in 83 (1) 1. (Article 3 (1) a))
EN 60 950: 1992 +A1: 1993 +A2: 1993 +A3: 1995 +A4: 1996 +A11: 1998

Harmonisierte Normen: Schutzanforderungen in Bezug auf die EMV §3 (1) 2, Artikel 3 (1) b))
Harmonised Standards: Protection requirements with respect to EMC 83 (1) 2, (Article 3 (1) b))

EN 50 082-1: 1992 Teile/parts: EN 61 000-4-2,3,4,6,
EN 50 081-1: 1992 Teile/parts: EN 55 022: 1994, EN 61 000-3-2,3

Schnittstellenspezifikation: NetzabschluR eines dffentlichen Tk-Netzes
Interface specification: Termination point of a public telecom. network
Spezifikation TBR3

specification:

Diese Erkldrung wird verantwortlich abgegeben durch:
This declaration is submitted by:

4 bt
Aachen, 14. April 2000

Aachen, 14" April 2000 i.V. Stefan Kriebel
Bereichsleiter Entwicklung
VP Engineering
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6.2 General Warranty conditions

The ELSA AG warranty, valid as of June 01, 1998, is given to purchasers of ELSA products in ad-
dition to the warranty conditions provided by law and in accordance with the following conditi-

ons:

1

a)

b)

c)
d)

2

Warranty coverage

The warranty covers the equipment delivered and all its parts. Parts will, at our sole discre-
tion, be replaced or repaired free of charge if, despite proven proper handling and adhe-
rence to the operating instructions, these parts became defective due to fabrication and/or
material defects. Also we reserve the right to replace the defective product by a successor
product or repay the original purchase price to the buyer in exchange to the defective pro-
duct. Operating manuals and possibly supplied software are excluded from the warranty.
Material and service charges shall be covered by us, but not shipping and handling costs
involved in transport from the buyer to the service station and/or to us.

Replaced parts become property of ELSA.

ELSA are authorized to carry out technical changes (e.g. firmware updates) beyond repair
and replacement of defective parts in order to bring the equipment up to the current tech-
nical state. This does not result in any additional charge for the customer. A legal claim to
this service does not exist.

Warranty period

The warranty period for the ELSA LANCOM Wireless-IL11access point is six years. The warranty
period for the ELSA AirLancer wireless adapter is two years. This period begins at the day of
delivery from the ELSA dealer. Warranty services do not result in an extension of the warranty
period nor do they initiate a new warranty period. The warranty period for installed replacement
parts ends with the warranty period of the device as a whole.

3

a)

b)

c)
d)

4

Warranty procedure

If defects appear during the warranty period, the warranty claims must be made immedia-
tely, at the latest within a period of 7 days.

In the case of any externally visible damage arising from transport (e.g. damage to the hou-
sing), the transport company representative and ELSA should be informed immediately. On
discovery of damage which is not externally visible, the transport company and ELSA are to
be immediately informed in writing, at the latest within 7 days of delivery.

Transport to and from the location where the warranty claim is accepted and/or the repaired
device is exchanged, is at the purchaser's own risk and cost.

Warranty claims are only valid if the original purchase receipt is returned with the device.

Suspension of the warranty

All warranty claims will be deemed invalid

a)
b)
c)

d)

if the device is damaged or destroyed as a result of acts of nature or by environmental influ-
ences (moisture, electric shock, dust, etc.),

if the device was stored or operated under conditions not in compliance with the technical
specifications,

if the damage occurred due to incorrect handling, especially to non-observance of the sy-
stem description and the operating instructions,

if the device was opened, repaired or modified by persons not authorized by ELSA,
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e)
)

9)
h)

5

if the device shows any kind of mechanical damage,

if in the case of an ELSA Monitor, damage to the cathode ray tube (CRT) has been caused
especially by mechanical load (e.g. from shock to the pitch mask assembly or damage to the
glass tube), by strong magnetic fields near the CRT (colored dots on the screen), or through
the permanent display of an unchanging image (phosphor burnt),

if, and in as far as, the luminance of the TFT panel backlighting gradually decreases with
time, or

if the warranty claim has not been reported in accordance with 3a) or 3b).

Operating mistakes

If it becomes apparent that the reported malfunction of the device has been caused by unsuitable
software, hardware, installation or operation, ELSA reserves the right to charge the purchaser
for the resulting testing costs.

6

a)
b)

c)
d)

e)

f)
9)

h)

Additional regulations

The above conditions define the complete scope of ELSA's legal liability

The warranty gives no entitlement to additional claims, such as any refund in full or in part.
Compensation claims, regardless of the legal basis, are excluded. This does notapply if e.g.
injury to persons or damage to private property are specifically covered by the product lia-
bility law, or in cases of intentional act or culpable negligence.

Claims for compensation of lost profits, indirect or consequential detriments, are excluded.
ELSA is not liable for lost data or retrieval of lost data in cases of slight and ordinary negli-
gence.

In the case that the intentional or culpable negligence of ELSA employees has caused a loss
of data, ELSA will be liable for those costs typical to the recovery of data where periodic
security data back-ups have been made.

The warranty is valid only for the first purchaser and is not transferable.

The court of jurisdiction is located in Aachen, Germany in the case that the purchaser is a
merchant. If the purchaser does not have a court of jurisdiction in the Federal Republic of
Germany or if he moves his domicile out of Germany after conclusion of the contract, ELSA's
court of jurisdiction applies. This is also applicable if the purchaser's domicile is not known
at the time of institution of proceedings.

The law of the Federal Republic of Germany is applicable. The UN commercial law does not
apply to dealings between ELSA and the purchaser.

[ ELSA LANCOM Wireless IL-l | )




Cm Appendix |

( | ELSA LANCOM Wireless IL-lI |




| Index

7

Index

Ziffern
TTRE oo 13
A
Access control ..o 55
Access protection ..o, 14

NAME oo 60

name or number ... 60

NUMDBET ..o 60
ACCOUNTING v 18
Ad hoc network ...........ccccoeeeae. 11, 50
Address administration ...................... 67
Address pool ..., 68, 73
Advice of charge ........cocooooorice 15
AirLancer Client Manager .................. 16
AOCD o 15
Automatic synchronization ................. 78
Availability ..o, 85
B
B channel

coNNection status .......ccccceveevevenne 16
BACP o 15
Barring ..o 55
Base Station ..o 10
B-channel protocol ..........cccocooovvrienvn. 60
Broadcast ..o 69
Brute force .....coooiveveeeee 15, 55
C
Call charge information ...................... 18
Call charge management ............. 62, 66
Call number recognition ..........c......... 14
Callback ..o 57, 61

fast call back ......ocooovveriee 61
Callback function ........ccocvveeveveeennee, 14

Call-by-call ..o 74,75
CAPI Faxmodem ...........c.c.cc......... 17,79
CAPlinterface .......ccocovoeeevevececeeennee, 80
CD e 21
Challenge Handshake Authentication
Protocol .....ooeeeeeeeeeeeeee e 60
Channel bundling .......coccooovvivoern. 15
AYNAMIC e, 15
static
CHAP <o,
Charge monitoring ........oooovoeveveeeenne. 15
charges
CLIP e
Closed network .........cccccovevecveveeennee,
ComPression ........cococovevreereeeeeeee.
Configuration ..........ocooooviiiei .
SNMP oo
Connect-charge structure
Connection duration .........ccccccoceeevee.e.
D
Data encryption .......ccccccoeeeeeeenennnn. 56
Data volume ......cocvvvececeeeecee 18
Days of the week ..o, 75
Detour
DHCP
DHCP mode
DHCP server
configuration ........ocoooveveeicecee 71
Dialing prefiX oo 75
Dial-up connection ..........cccooooveerreneve. 40
Dial-up Networking .........cccccccevvevnn.. 61
DNS server .......ccooeveveein. 17, 67, 69
DSL oo 53
DSST e 13
Dynamic channel bundling ................. 15
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®E
Electronic documentation ................
End address ...
Ethernet ..o,
10Base-T ..o,
Ethernet connection ..........................
EuroFileTransfer ...

®F
Factory defaults .......cccoooveveceeee
Fast Call Back .........ccooovoi

Fax Class 1 ..o,
Fax driver ...,
Fax transmission
Faxmodem ...
LANCAPI ...
Filter ...
Firewall ..o
Filter list ..o
Object list oo
Rule table ..o
Firewall function
FirmSafe ...
Firmware ...,
Firmware upload
using TFTP oo
with LANconfig
Flash ROM ...,

® G

Gateway ..o 61, 67, 69

®H
High telephone costs ..........ccccocceeeene
holidays ....c.cooooeiiii e

LN
Identifying the caller ...........ccccoco......
Inband

using telnet ......ocooovoveeceeee
Infrastructure network
Install software ..o
Installation ...
Internal clock ...
International calls .............................
IPaddress ..o,
IP masquerading ....................
ISDN oo,
ISDN cable ..o,
ISDN connection cable
ISDN time .o,
ISDN-Sg-Anschlu ..o

L
LAN e, 10
LAN connection ............
LAN connector cable ...
LANCAPL ... 17, 80
LANCAPIClient ....cooveeeeeeeee . 81
LANCAPI-SEIVEr oo 83
LANCOM
LED indicators
LANconfig ..............
LANmonitor ...
LCR e
LCRtable ..o
Least-cost router
automatic fallback ... 77
connect-charge monitoring ............. 77
operating modes
Least-cost routing
LED o,
LAN Status ..o,
Power/MSg ......ccveeeeeeeceeeee.
Line connection ..o
Line management
Local area network
Localcalls .cooovveveiena.
LOGIN oo
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Long distance calls ........cccccoccvvirnne 75
M

MLPPP o, 15
MOGE e 67
MOoNItoring .....ooovevee e 46
Multi-device terminal ...........ccccccooce.... 13
N

NAT 57, 61
NBNS server ..o 67, 69
Neighboring local exchanges ............. 76
NetBIOS .o 18
Network identification prefix ............. 74
Network operators ...........ccccceceveuennnne 74
0

Office communications ...................... 80
Online media ......ccoovoveveeceeeceee 37
Online time ..o, 18
Operating modes .........cccocoveoreiereenne. 49

Options for saving telephone charges 76

P
Package contents .........c.ccccccoceeeennee.
PAP ..o,
Password ........ccoccoeene.

Password protection
PAT oo
Peer-to-peer network

Period of validity ........cccccoeeeennne.

Point-to-multipoint configuration ....... 13
Point-to-point configuration ............... 13
Point-to-point network ..........ccccco....... 52
POr o 84
Power adapter ........ccccococovveeecnnnne, 21
PPP e 61
PPP client ..o 40
PPP connection ..o 4

PPPList .o 60
PPP negotiation ..........cccoovvverveecennee. 42
PrefiX oo, 74
Preselection ..o 74
Priority control ..o 85
Provider ..o, 74
PrOXY oo, 18
R
Radio cell oo 10
Radiofrequency channels .................. 91
Range ..o, 1
Rate zones .......ocooeeeeeeceeceeee, 76
Remote connection ...
Reset button ........coooveeveiicceecee, 27
Roaming ...cooveeeeeceeeeee e, 1
S
So StAUS oo,
So-Schnittstelle ...
SECUMLY v
DEVICE v
WLAN e
Security procedures ..........ccccocevene... 60
Single USer access ........ccccoveeeennee. 61
SNMP e, 43
Software update .........ccocoovioriecnne. 14
Special prefixes
Specifications ..o,
Standard fax programs ....................... 79
Start address
Static channel bundling ...................... 15
Station filter ... 56
SEAtiStiCS ovvveecee e, 16
Status displays ....cccoeeeeecieeeeeeeee, 16
Subnet mask ..., 69
System terminal ........cocooooeiiieeee 13
T
TCP/IP e 30
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Telephone provider .........cccccveeeeeee.
Telnet oo,

TIMe o 75,78

Time check ...
Time inthe ISDN ...,
Time of day oo
Transfer costs ..o
Transmission rates ...,
Troubleshooting .......cccooooeveceec.

o\vu
Upload ..o
User name

ow

WAN Chan® ...,
WAN Chan2 ...,
WAN connection

Warranty conditions .........c.ccoeeeenn. 94
WEBcOnfig ......ooveeeeeeeeeen. 44, 45
WEP 56
Windows networks ... 18
Winipefg oo 32
Wireless Internet Gateway ......... 52, 53
Wireless LAN ...
Wireless network

Wireless network adapter ................. 10
WLAN

WWW
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